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Quick Start

Here are guidelines for quickly getting up and running with the 405™
Microplate Washer LS:

Install the 405 LS page 7
Follow instructions for

- ——removing-shipping-hardware
and installing the instrument.

Optimize performance page 29
Review the best practices for

|| N optimal performance.

Review the Safety page 89

Information

Copy the 405 LS
Operator's Manual to your

.
//‘.

o0
A

computer to make it easy to
find reference information in
the future. The complete
operator's manual is delivered
on the USB flash drive shipped
with the instrument.
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Notices

BioTek® Instruments, Inc.
Highland Park, P.O. Box 998
Winooski, Vermont 05404-0998 USA

All Rights Reserved

© 2015, BioTek® Instruments, Incorporated. No part of this publication may be
reproduced, transcribed, or transmitted in any form, or by any means electronic
or mechanical, including photocopying and recording, for any purpose other

Trademarks

BioTek® is a registered trademark and 405™ Microplate Washer LS is a
trademark of BioTek Instruments, Inc.

Microsoft®, Internet Explorer®, Windows® Windows 7, Windows 8, and Excel®
are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a
commitment by BioTek Instruments, Inc. Changes made to the information in
this document will be incorporated in new editions of the publication. No
responsibility is assumed by BioTek for the use or reliability of software or
equipment that is not supplied by BioTek or its affiliated dealers.
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Contact Information

BioTek® Instruments, Inc.
Highland Park, P.O. Box 998
Winooski, Vermont 05404-0998 USA

Customer Service and Sales

Internet:

Phone:

Service/TAC

Phone:

Fax:
E-Mail:

www.biotek.com
888-451-5171 (toll free in the U.S.)
802-655-4740 (outside the U.S.)
802-655-7941
customercare@biotek.com

800-242-4685 (toll free in the U.S.)
802-655-4740 (outside the U.S.)
802-654-0638

tac@biotek.com

European Coordination Center/Authorized European Representative
BioTek® Instruments GmbH
Kocherwaldstrasse 34
D-74177 Bad Friedrichshall

Germany

Internet:
Phone:
Fax:
E-Mail:

www .biotek.de

+49 (0) 7136 9680
+49 (0) 7136 968 111
info@biotek.de

BioTek Instruments, Inc.
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BioTek's Customer Resource Center (CRC) continues our tradition of superior
service and support. After an easy registration process, you can access lots of
useful information about your BioTek microplate instrumentation and software. On
the secure CRC website, you can:

Track orders

Access warranty information, user manuals and software updates
Download technical and application information

Maintain equipment inventory (product registration)

Request service and technical support

View-service-history.

And much more!

Register at https://customer.biotek.com

Warnings

Operate the instrument on a level, stable surface away from excessive
humidity.

When operated in a safe environment, according to the instructions in
this document, there are no known hazards associated with the 405 LS.
However, the operator should be aware of certain situations that could
result in serious injury; these vary depending on the instrument type.
See Hazards and Precautions (as described on page 90).

Strict adherence to instrument maintenance and qualification
procedures is required to ensure accurate dispense volumes and risk-
free operation.

405™ Microplate Washer LS



Install the 405 LS

Follow the instructions in this section to install your

instrument:

Unpack and Inspect the Instrument ... 8
Remove the Shipping Hardware ................ ... 8
Setting Up the 405 LS ... . .. .. s 12
Install Software/Connect to Computer ... 19
Connect Power Cable ... ... ... 20
Define Instrument Settings ... ... ... .. 21

Verify Performance ... ... ... ... 23
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Important: Save all packaging materials. If you need to ship the instrument or
accessories to BioTek for repair or replacement, you must use the original packaging.
Using other forms of commercially available packaging is not recommended and can void
the warranty. Improper packaging that results in damage to the instrument may lead to
additional charges. Refer to the operator's manual for repacking instructions.

Inspect the shipping box, packaging, instrument, and accessories for signs of
damage.

If the 405™ Microplate Washer LS is damaged, notify the carrier and your BioTek
representative. Keep the shipping cartons and packing material for the carrier’s
inspection. BioTek will arrange for repair or replacement of your instrument
immediately, before the shipping-related claim is settled.

1. Unpack the boxes containing the instrument and other equipment:
« 405™ Microplate Washer LS and accessories
« Vacuum Pump and accessories
« Vacuum Filtration Accessory Kit
« Additional 192-tube washer manifolds for 384-well plate processing.
2. Place all packing materials back into the shipping boxes for reuse if necessary.

Refer to the Package Contents on page 115 to make sure you have all expected
equipment.

Remove the Shipping Hardware

The 405 LS is shipped with a protective manifold shipping bracket. Remove this
bracket before using the washer and reinstall it prior to shipping to avoid
irreparable damage to the manifold. Failure to remove and reinstall the shipping
bracket may void your warranty.

Keep in mind that you must reinstall the shipping hardware and use the original
shipping material if it is necessary to return the instrument to BioTek for service or
repair.

405™ Microplate Washer LS
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Remove the manifold shipping bracket

— Ll IS .
_ 1. Use the 9/64” (3.57 mm) hex wrench to

unscrew the cap screws at the base of the
shipping bracket and remove it.

2. Slide the bracket towards you and remove.

- Most brackets are black, unlike the
one shown here.

3. Store the bracket: mount it on the back panel,
on the studs provided.

"Q" Models

- "Q" Models have
three shipping
brackets:
remove two
before powering
up, and the last
one after start

up.

—

BioTek Instruments, Inc.
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1. Use the 9/64” hex wrench to unscrew the
cap screws and remove the bracket on the
side of the wash manifold that holds the
Verify sensor in place.

2. Remove the large bracket in front holding
the wash manifold: Remove the three
screws. Slightly lift the manifold(s) to
release the bracket from the base, and pull
it away from the manifold(s).

3. Set the brackets, screws and washers aside.

Follow instructions to set up the washer, e.g.
install the vacuum pump-and tubing. Then,
perform Step 4, below.

o ‘ Verify ™ Technology unit || !

4. When you're ready to power up the
instrument, plug it in and turn it on.
Release the latch on the left side of the
Verify™ sensor unit, and to lift it up to
remove the third shipping bracket.

5. For safe keeping, put the cap screws and

&k : washers for the two thin brackets in the
| | Storethescrews studs provided on the longest, last-
A in the brackets removed bracket.

6. Put the manifold bracket's top screw back
in its hole. Save the two longer screws for
storing all the brackets on the back of the
instrument.

405™ Microplate Washer LS
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Layer the brackets on top of each

other on the studs on the back. m

—

7. Store the brackets: mount them on the back
panel on the studs provided. Beginning
with the longest (3rd) bracket, layer the
brackets on top of each other, and use the
longest screws to secure them in place.

BioTek Instruments, Inc.
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Important: Avoid excessive humidity. Condensation directly on the sensitive
electronic circuits can cause the instrument to fail internal self checks.

Install the instrument on a level, stable surface in an area where ambient
temperatures between 10°C (50°F) and 40°C (104°F) can be maintained.

The instrument should be operated in a non-condensing humid environment
having a maximum relative humidity of 80% at temperatures up to 31°C
decreasing linearly to 50% relative humidity at 40°C.

Connect the Vacuum Pump, Tubes, and Bottles

For optimal operation of the 405 LS, all tubing, cables, and fittings for the fluid
supply and waste systems must be properly connected. This image illustrates
the rear panel of the instrument and the locations of the ports and connections
for the fluid supply and waste systems.

waste
nmu‘:ucu CONTROL Sensor

@r_*

. < Connect Pﬁzcg:i ) Connect to
DISPENSE ol ing pnect
FLUID 1N : fluid Supply et waste

BUFFER -C* BUFFER “D*

Y
i,

Rear Panel

Waste System

\

I
—3 Caution! Pump Installation. Do not plug the vacuum pump cable
into a wall outlet! Connect it to the Accessory Outlet on the back of the
instrument. This allows the 405 LS to regulate the pump, turning it on and off

405™ Microplate Washer LS
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as specified by the protocol.

7AAN

When using a standard pump (rather than the high flow pump), set the
instrument’s Vacuum Dissipation Delay to prevent the pump from drawing
excess current and blowing the 5-amp fuse. See Define Instrument Settings on

page 21.

« Note: The waste tubes have colored bands that match similarly colored
dots next to the inlet/outlet ports on the waste bottle caps to ensure the
correct connection of the tubing.

« BioTek strongly recommends installing the vacuum line filter to protect
your vacuum pump: See Install the Vacuum Line Filter on page 15.

Direct Drain Waste System: Follow instructions provided with the direct drain
module (and included on the operator's manual USB stick) to install the direct drain
waste system, if purchased.

BioTek Instruments, Inc.
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Standard Waste System - 4L, 10L, or 20L Bottles

Connect the tube
from the waste bottle
without the waste
sensor cap, to the
VACUUM port.

Connect the
4 waste sensor
| cable toits port. [

Connect the tube
from the waste bottle
with the waste sensor

cap to the vacuum

pump.

= our

VACLUUM

wi-trw't‘h‘é-s'ﬁo.rfe"s'fﬁbe, -
aligning the colored §
labels.

Standard Waste System

Three lengths of tubing are shipped with the waste module:

Tubing: Connects:

Short tube with yellow and green bands — Thetwo waste bottles to each other
Long tube with green bands on both ends — Bottle without sensor to vacuumport
Long tube with yellow and orange bands — Bottle with waste sensor to the vacuum

pump

1. Locate the quick-release caps shipped inside the waste bottles and attach the

tubing to them as follows:

2. Connect the waste bottles to each other using the shortest length of tubing,
matching the colored bands on the tubing to colored dots on the caps.

3. Attach the waste sensor cable to the Waste Sensor port on the back of the

washer.

405™ Microplate Washer LS
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4. Attach the tube from the waste bottle with the waste sensor in its cap to the
vacuum pump.

5. Attach the tube from the waste bottle that does NOT have the waste sensor in
its cap to the Vacuum port on the back of the instrument.

6. Important! When installing BioTek’s vacuum pump, connect the pump’s AC
power cable to the vacuum pump Accessory Outlet on the back of the
instrument. (Use the accessory outlet adapter provided, if applicable.)

7. Place the waste bottles and vacuum pump on the same horizontal plane as the
instrument or below it, such as the floor beneath the work surface. This will help

optimize performance.

8. Make sure the waste bottle’s caps are well sealed.

Install the Vacuum Line Filter

The optional vacuum line filter (PN 48294) can be installed halfway between the last
waste bottle (overflow bottle) and the vacuum pump.

To do this, cut the tubing and insert the filter, noting the direction of flow. Point the
flow arrow on the filter toward the vacuum pump.

In the event of a fluid overflow, the filter should prevent the destruction of the
vacuum pump’s internal components. If an overflow does occur, check the filter for
trapped fluid. If fluid is found in the filter, remove the filter and drain using the
small white nut on top of the filter. Tighten the white nut and reinstall the filter.

BioTek Instruments, Inc.
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Install the Fluid Supply System

| Important:
Never run the
washer without
the filter on
the supply
“tubing (inside

| the bottle).

Use the adhesive labels provided toidentify
the buffer bottles and their tubing.

Prepare the supply bottles and tubing;:

1. Remove the Quick Release Connector
from its bag inside the supply bottle
and connect it to the raw supply
tubing provided.

« You may need to cut the tubing to the
desired length.

2. Snap the connector into the top of the
supply bottle.

405™ Microplate Washer LS
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Make sure you hear the
connector click!

Attach the labels provided
with the washer to identify
the buffer bottles.

Note: To avoid spilling fluid when refilling bottles or changing reagents, first release the
Quick Connector from the bottie cap, use a paper towel to sop up the few drops in the cap.
Then, refill the bottle.

With Buffer Switching (4 Buffers):
1. Place the four supply

bottles on the same BUFFER “B"
surface as the
instrument.
2. Connect the tubing from
one of the supply bottles R UFFER “C~ s

to the “A” port on the
back of the washer.

3. Repeat step 2 with the
other three supply
bottles for “B,” “C,” and
“D” Buffers.

BioTek Instruments, Inc.
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1. Place the supply bottle(s) on the same
horizontal plane as the instrument.

2. Connect one the tubes to the Dispense
Fluid In port.

Install the Microplate Carrier

« Make sure the serial number on the underside of the plate carrier
matches the washer's serial number. If the numbers do not match, call
BioTek TAC immediately.

1. Line up the tab on the underside of the carrier with the slot on the carrier
transport block.

2. Put the two carrier rail guides onto the transport rail. The tab should sit in the
slot.
Final Check

« Verify that the tubing was not crimped during installation.

« Ensure that there are no loose fittings or cable connections.

405™ Microplate Washer LS
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Attach the Mist Shield

1. Loosen the two thumbscrews in
the front base of the instrument,
directly in front of the washer
manifold and priming trough.

2. Position the mist shield so the
gaps align with the thumbscrews.
One side of the mist shield rests
on the instrument base. The top
rests on the two rubber pads
above the manifold.

3. Finger-tighten the two
thumbscrews to hold the shield
in place.

A
) Always lift the mist

shield straight up, not towards
you, when removing it.

405 LSs equipped with Verify™ Clog
Detection Technology ("Q" models)
have a smaller mist shield.

Install Software/Connect to Computer

If you purchased BioTek's Liquid Handling Control™ (LHC) Software to control the
405 LS using your personal computer (PC), please refer to the LHC Installation Guide
for complete installation and setup instructions.

BioTek Instruments, Inc.
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Connect to Host Computer — — e

Using the USB cable: Plug one end into the USB port labeled Computer on the
instrument and the other end into an available port on the computer.

Important: Follow the instructions provided on the LHC software flash drive in the "USB
Driver" folder to install the necessary drivers and identify the Com Port number.

« The keypad must be displaying its “Main Menu” for the LHC to
communicate with the instrument.

& Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You
can use USB to connect the 405 LS to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Connect Power Cable

|
' Warning! Power Rating. The 405 LS must be connected to a power
receptacle that provides voltage and current within the specified rating for the
system. Use of an incompatible power receptacle may produce electrical

shock and fire hazards.

|
= Warning! Electrical Grounding. Never use a two-prong plug adapter
to connect primary power to the 405 LS. Use of a two-prong adapter
disconnects the utility ground, creating a severe shock hazard. Always
connect the system power cord directly to a three-prong receptacle with a
functional ground.

The 405 LS supports voltage in the range of 100-240 V~ at 50-60 Hz.

1. Plug the power cable into the power cable socket in the rear panel of the 405
LS.

2. Insert the three-prong plug into an appropriate receptacle.

405™ Microplate Washer LS
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Define Instrument Settings

LHC Users Only
N
" When using the LHC to control the 405 LS, an important first step is defining
your instrument’s settings. After installing the LHC, you can use the desktop icon
or the Windows Start button to launch the LHC:

> All Programs> BioTek> Liquid Handling Control
1. Click the Name link on the main page and, if required, select the 405 LS.

2. Specify the COM Port used to connect the 405 LS to the computer (use the drop-
down list to select the port) and click Test Communication.

« Pass: proceed to the next step.
« Fail: check the Com Port setting. See “About Com Ports” in the LHC Help.

3. In the Target Instrument Settings dialog that opens, click Get actual settings
now, and click OK.

Standard Vacuum Pump Users

. Do not perform this step when using the High Flow vacuum pump. High
flow pumps are recommended when aspirating 384-and 1536-well plates
with non-surfactant wash buffers (e.g., pure deionized or distilled water).

Perform this step ONLY if you are using the “standard” vacuum pump: increase
the Vacuum Dissipate Delay to match your waste container: 1 second per liter.
For example, if you have a 10 L waste bottle, set the delay to 10 seconds.

BioTek Instruments, Inc.
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‘ Using the LHC | Using the Keypad

1. Select Tools>Instrument 1. Press Setup Menu.
Utilities. )

. = Select the arrow (for more |
( 2. Under General Settings, increase options) then, ADVANC.
the Vacuum DISSIpate. Delay to 3. Select VACDIS.
match your waste container: 1
second per liter.

3. Click Send to download this new
setting to the instrument.

4. Use the number pad to set the
Vacuum Dissipate Delay to
match your waste container: 1
second per liter.

4. Click Exit to return to the main 5
screen.

. Press Main Menu upon
completion:

Define Startup Preferences (LHC users only)

You can save enormous time creating protocols by following these steps to define a
New Protocol template and use it at startup.

Create a protocol template

1. 177 Click the New button or select File>New.

2. Click Name. Select the 405 LS and define its Port and Settings.

3. Highly Recommended: select the Plate Type, fill in the text fields, and add any
steps that you want all new protocols to include.

: H Click Save and assign a unique name, e.g. Template.LHC.

4

5. Select Tools>Preferences>New Protocol.

6. @ Select the button for Protocol selected below to use as a template.
7

. Click selected and select the protocol you created as a template.

Define startup behavior:
8. After completing the steps above, select the Startup Options tab.

9. Select the button for New Protocol.

10. Click OK to save your new preferences.

405™ Microplate Washer LS
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Verify Performance

Before using the 405 LS for the first time, verify that it is operating properly.

« When using the LHC, make sure the 405 LS is connected to the PC and both are
powered up.

« When running standalone, turn on the 405 LS.

Using the keypad:
1. Select UTILS at the main menu.
2. Select TESTS > SLFCHK.

Using the LHC:
1. Click the Name link on the main page and, if required, select the 405 LS.
2. Define the COM Port used to connect the 405 LS to the computer and Test
Communication.
3. In the Target Instrument Settings dialog that opens, click Get actual settings now,
and click OK.
4. Select Tools>Instrument Utilities

5. On the General Settings tab, click the Perform Self-Check link.

Test results:
. Pass: no error message is displayed.

. Fail: an error message is displayed. If this happens, note the error code and refer
to Troubleshooting on page 99 to determine its cause. If the problem is
something you can fix, turn off the instrument, fix the problem, and then turn the
instrument back on. Otherwise, contact BioTek’s Technical Assistance Center.

The Qualification Chapter in the operator’s manual provides Installation and
Operational Qualification procedures to perform after the instrument is installed and
before the instrument is used in a laboratory environment.

« Important! Before operating the instrument, review Optimize
Performance on page 29. The guidelines include necessary steps to
perform before running a protocol, and issues to consider when creating or
editing protocols.

BioTek Instruments, Inc.
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1. Fill the washer’s supply bottle (bottle “A” for buffer switching models) with
approximately one liter of deionized water.

| LHC  Keypad
1. Select File > Open. 1. Select RUN at the main menu.
2. Open the 405 LS and the Prime and | 2. Run DAY_RINSE: Press ENTER to
l Maintenance Protocols folders. confirm selection of the protocol
Open the applicable "Buffer" folder, and press START to run the
and then open W-DAY_RINSE.LHC | protocol.(Press the Options key to
You may need to reset the Com scroll to the protocol if necessary.)
Port. 3. When the protocol is completed,
3. When ready, click the Run button press Main Menu.

to prime the tubing and manifold
with deionized water.

4. When finished, close the program.

If leaks were detected, tighten all tube fittings and re-run the program. If leaks are
still detected, contact BioTek’s Technical Assistance Center.

Run the Verify Test ("Q" Models Only)
If your 405 LS is equipped with BioTek's Verify™ Technology, run the test:

Important! Before running the test:
Make sure the 405 LS is primed and ready to run:
« Fully prime the tubing/system, e.g. run Day Rinse.
« If necessary, empty waste vessel and tighten waste bottle cap.

Prepare to run the Verify test:
« Fill the supply vessel with at least 100 mL dH20 or DI water or buffer solution®.

1po not use highly viscous fluids or wash buffers that are prone to leave significant residue on the plate.

405™ Microplate Washer LS
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Run the Verify test:
LHC |

1. Select Tools>Instrument Utilities>Verify Manifold and click Run a new
Test.

. Buffer: Select the bottle to use, if applicable.

. Prime: optionally, prime the manifold tubes to correct for evaporation loss. 40
mL of fluid is dispensed.

« %CV Threshold: optionally, change the %CV to match your lab's standard for
QC tests: 5-15%. The default value of 5% is recommended.

2. Press Start to run the test.

3. Assess the results: Verify Results. (Refer to the operator's manual for a complete
description of the Verify Technology process and procedure.)

B
—) Do not discard the Verify Test Plate. Reuse it for as long as possible.

Contact BioTek TAC if any of the tests fail.

BioTek Instruments, Inc.
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Basic Operation

This section introduces the basics of operating the 405 LS. For
more detailed-and comprehensive instructions, please referto—
the operator's manual on the CD shipped with this guide.
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Introducing the 405 LS Keypad ...... ... ... 31
Predefined Protocols Listing ........ ...l 42
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Using LHC to Control the 405™ Washer ... 46
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Cell Wash ... i 55
Biomagnetic Separation - Magnetic Bead Assays ......................... 60
Manifold Stop Screw Adjustment Kit .......... ... 66
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AUBOP I M e e e 74




28 | 405 LS Getting Started Guide

Basic Operation - - - -

Two ways to control the 405 LS

You can control the 405 LS using its built-in keypad or with BioTek's Liquid
Handling Control™ (LHC) software.

To use the LHC to control the instrument, it must be attached to and
communicating with your personal computer (PC), and its main menu must be
displayed. Basic protocols can be created or modified using the LHC, and then
downloaded to the instrument for stand-alone operation. Learn about
transferring protocols from the LHC to the instrument in the LHC Help system:
select the Help menu or click a Help button in a window.

« Find instructions for using the LHC beginning on page 46.
« Keypad instructions begin on page 31.

Two ways to wash a plate
The 405 LS offers two ways to wash a plate:

« Quick Wash: using the keypad you can wash a plate by defining a few
parameters like fluid volume and number of wash cycles and rely on default
parameters for the more advanced options.

+ Run a Wash Protocol: using either the keypad or the LHC you can run a wash
protocol to wash a plate. You can run a predefined protocol or define your own
protocol to specify the optimal parameters for your assay. See RUN: Running
Predefined Protocols on page 40.

405™ Microplate Washer LS
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Optimize Performance

Here are some guidelines to ensure optimal performance and to prevent problems.

Keep the devices clean and the tubing wet

The most critical factor for ensuring optimal performance is to adhere to the
Recommended Maintenance Schedule on page 79. Enable AutoPrime to keep tubes
from clogging.

Prime the tubing to remove air bubbles

See 405 Recommendations for Priming the Washer on the next page

Best Practices for all 405 LS Devices

Fill the supply bottles with sufficient fluid. Never run the 405 LS without the fluid
filter installed (on the end of the tubing inside the supply bottle).

Note: To avoid spilling fluid when refilling bottles or changing reagents, first release
the Quick Connector from the bottle cap, use a paper towel to sop up the few drops in
the cap. Then, refill the bottle.

Make sure the bottles, solutions, and tubing are clean and do not contain any
particles or mold. Solutions that are recycled over several days will grow algae,
bacteria, molds, or other undesirable organisms.

Prime before dispensing. Priming the tubing is the most critical factor in assuring
optimal performance.

Empty the waste bottles and firmly seat the bottles’ caps and quick release
connectors. To make sure fluid does not back up into the vacuum pump during
operation keep the waste sensor cable installed and the waste detection sensor
activated. If fluid collects in the overflow bottle, thoroughly rinse the fluid-level
switch and bottle.

Check the external tubing connections for kinks and clogs.

When equipped with BioTek's Verify™ Technology ("Q" models), before
processing your assay plates, take five minutes to run the Verify routine to
ensure the manifold tubes are not clogged. Also, enable the Plate sensor
(Instrument>Options>Plate Detection) to ensure a plate is present on the carrier
before a run begins.

Put microplates on the carrier with well Al in the left rear corner as you face the
instrument, and firmly seat the plate in the carrier.

To more quickly dispense to 384- and 1536-well plates, use the Instrument
Utilities to change the Dispense Pattern to Row. If precision is more important
than speed, keep the pattern set to Column.
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—— 405 Recommendations for Priming the Washer

These recommended prime volumes are required to achieve 95% or higher purity
when changing wash buffers.

Model Buffer Switching | One Buffer
405TS/LS 300 250
HT 300 250

Buffer Switching models have four buffer valves; otherwise, only one reagent bottle
may be connected to the washer. For Select models (with Cell Wash (CW)
capability), the recommended prime volume is the same with and without Buffer
Switching.

Model | Quick Prime | Prime step

Select | 300 Main | Low Flow

150 | 150

Manifold Prime: 50 mL is recommended to clear air from the manifold only and
to wet the tips. This is recommended before running a protocol to correct fluid loss
due to evaporation.

Dead Volume

BioTek's recommended prime volumes are based on purity testing and measured
dead volumes. Generally, priming with three times the dead volume assures

purity.
Model Dead Volume
405 TS/LS 108 mL
_H_T T _1_08 m_L
Select 129 mL

For models with buffer switching tubing, dead volume is + 2 mL additionally.
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Introducing the 405 LS Keypad

The keypad on the 405™ Microplate Washer LS features 26-keys and a 2 x 24-
character LCD. The main menu is shown below.

LCD display 405 LS Washer BIO AP i
RUN QUICK  DEFINE  UTILS | < LMenu functions

SoftKeys (4) . (second line of

0006

7.8, 9 B3 BB

Mal l Setup [Previous
=>| 4p 5e G- ey Meny | Serean - Special function keys

1a 26 3c [ESNESHERY

| *  Shift @ @
L 0 i

Alphanumeric
keys

i

Starting at the top of the keypad, note the main menu and the Soft-keys. Use the
Soft-keys to make selections. To return to the main menu, press the Main Menu key.

At the main menu, the top line displays AP when AutoPrime is enabled and BIO
when the washer is set to interface with and control the BioStack.

. RUN - to run a previously defined protocol. Use the Options key to select a
protocol or enter its number. See Predefined Protocols Listing on page 42.

« Turn On/Turn Off the Vacuum Pump to drain the priming trough. At the
Quick menu:

« Press Shift+1 to turn on the vacuum pump.
« Press Shift+2 to turn off the vacuum pump.

. Use these key sequences to manually control the vacuum pump when
dispensing fluid. At times the priming trough fills up and is not emptied
automatically. This option gives you control in that situation.

« QUICK - leads to simplified wash, prime and Ultrasonic Advanatage™ options.

. DEFINE - leads to the protocol creation and editing mode: Create or Edit a
Protocol on page 33.
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— %+ UTILS —to run system tests, the Adjust Utility, and to define AutoPrime
parameters.

« Setup Menu: press this key to access the instrument’s general settings and
the settings for the BioStack.

« The Options key (and sometimes the arrow keys) scroll through the
available options or settings for the current focus. Shift+Options reverses the
scrolling direction.

Quick Wash (Keypad only)
Select QUICK>WASH at the main menu to perform a quick wash.

96 WASH: 003 VOL:0300 A
PLATE CYCLE  BUFFER

Quick Wash Menu

« Only options applicable to your model are displayed.

« 96 in the above example is the plate type. Select PLATE to change it; scroll
through the compatible choices for plate washing with the currently installed
hardware and press Enter to select the desired plate.

« WASH:003 is the number of wash cycles (one aspirate and dispense step per
cycle). Select CYCLE to change the number of cycles to perform.

« VOL:0300 uL shows the dispense volume per well in microliters.

To change the dispense volume, use the arrow keys to move the
cursor to the desired number position. The cursor appears to underline a number:
0010. When the correct position is selected, use the number pad to enter the desired
value. Or, press Options to increment the value, Shift+Options to decrease the value.

. Buffer is offered on washers with Buffer Switching to select the buffer valve.
The current selection is displayed in the top right corner of the LCD.

« PLATE lets you change the selected plate type and define a partial plate run,
if applicable.

r

A _d When the desired values are entered, put a plate on the carrier and press

Start to run the routine.

If Quick Wash is too limited to satisfy your assay requirements, use the LHC or the
keypad to define a wash protocol. All wash parameters can be defined during
protocol creation, including those designed for special assays.
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Quick Prime (Keypadonly) a L

Priming removes air bubbles from the tubing, ensuring optimal performance. Fluid is
dispensed to and aspirated from the priming trough. You can use Quick Prime to
comply with the daily maintenance recommendations.

Select QUICK>FULPRM or MANPRM to prime the washer.

FULL PRIME VOL:0300 A
BUFFER (300...999)

QuiZk Prime Menu

. Choose FULPRM to flush all the tubing, when changing fluids, for example. The
valid volume range is displayed, 300 to 999 mL in the above example.

« Choose MANPRM prior to running a protocol to correct for evaporation, i.e. to
normalize the dispense tips and remove any air from the manifold.

. VOL:0300 mL shows the dispense volume per well in milliliters.

To change the dispense volume, use the arrow keys to move the
cursor to the desired number position. The cursor appears to underline a number: 0010.
When the correct position is selected, use the number pad to enter the desired value. Or,
press Options to increment the value, Shift+Options to decrease the value.

. Buffer is offered on washers with Buffer Switching to select the buffer valve.
The current selection is displayed in the top right corner of the LCD.

o

When the desired values are entered press Start.

See 405 Recommendations for Priming the Washer on page 30.

Create or Edit a Protocol (Keypad Only)

At the main menu:

1. Select DEFINE, and then, CREATE or EDIT.
CREATE EDIT

2.  Name the protocol and select | Select the protocol to edit:
the Plate Type. Press Enter enter its number or use the
after making selections to Options key to scroll through
proceed. See How to name a the stored protocols to select
protocol (Keypad only) on page 39 | one. Then, you can edit the

name and plate type, if

desired. Press Enter to
proceed.
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- 3. Define or modify the plate type using the Previous and Next

buttons to scroll through the supported Plate Types (if
applicable).

4. Select ADD to define the first
step: then, select the wash

EDIT the first step or press the
Options key to scroll to the

action or SHAKE to mix or soak | step you want to change in a
the plate’s contents.

multi-step protocol.

5. Define the step’s parameters. Press Enter to proceed.

6. Keep Added Step?

Save Step Changes?

Select Yes or No using the Soft-keys to save or discard your
inputs for the current step.

Press Main Menu to end the session at any time. Then, select
RUN and select the protocol to run it.

Wash Step Parameters Table

Minimally, a wash step includes an aspirate step followed by a dispense step.
Select and define each option to customize the parameters for your assay.

Keypad Option Description/Values range g L
name values
CYCLES Number of | Each wash cycle first aspirates and 3
wash cycles: | then dispenses fluid to and from the
plate.
ASPIR Aspirate | Vacuum Filtration: Select standard
| aspiration (Top) or Vac for filtration.
Filtration | When applicable, specify duration of | 30
Time: | vacuum filtration in seconds. 5-999

405™ Microplate Washer LS




Introducing the 405 LS Keypad| 35

| K;y_pad
name

Option

Description/Values range

Default
values

Travel Rate:

The rate at which the washer
manifold travels down into the wells.
The selection range is 1 to 5 for non-
cell-based assays, from slowest to
fastest. With these rates, the tubes
slow their descent as they approach
the defined aspirate height (Z
Position) to aid complete evacuation
of the well.

For delicate, cell-based assays, the
range is 1ICW (cell wash) to 4CW and
6CW. These rates minimize
turbulence in the wells. The tubes
descend at a constant rate to the
specified height. Rate 6CW creates
the least disturbance and performs
fastest.

3

Delay:

Amount of time the tubes stay at the
aspirate height before lifting out of
the wells. Define a delay between O -
5000 ms. Increasing the delay may
improve evacuation of the wells.

Positioning:

X- and Y- horizontal axes, Z- height
(vertical) axis can be adjusted to
improve performance. Default Z-axis
for 384-well plates is 22 steps, 2 for

Z = 29 for
96-well
plates;
X&Y=0

384-well PCR plates.

Secondary
aspirate:

| Also called Crosswise Aspiration.

| First the wells are aspirated using

| the position defined above. The

1 aspirate tubes rise and then descend
to the secondary position to aspirate
again.

Dispense

No
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Keypad Option Description/Values range Detayl
name values
Flow Rate: The rate at which the fluid is 7
96-tube & dispensed from the tubes. For cell-
192-tube based assays, use rate 1 or 2 for
manifolds gentle washing with the 96-tube
manifold only. For normal dispensing,
the range is 3-11, 3 is slowest and 11
is fastest.
Volume HL/well dispensed range: puL/well:
96-tube manifold: 50-3000 96= 300
192-tube manifold: 25-3000 o0 400
Buffer: Buffer bottle selection. A-D A
Positioning: | X- and Y- horizontal axes, Z- height | Z = 121 for
(vertical) axis can be adjusted to 96-well
improve performance. Default Z-axis | plate
for 384-well plates is 120 steps; 83
for 384-well PCR plates.
Vacuum Suspends the vacuum pump until a 10
Delay certain volume is dispensed. This
feature is critical to cell wash
operations. It delays normal
aspiration until the specified volume
has been dispensed to the wells. The
range is 10 to 350 pL/well.
OPTS Options
PRE Pre-wash options: Pre-dispense,
Bottom wash (if applicable)
MIDCYC Mid-cycle options: Shake, Soak, Pre-
dispense between cycles,
POST Post-wash option: Final Aspirate
FORM Format for washing 384-well plates:
Plate or Sector
PRE Pre-wash Actions performed before the wash
cycles begin
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Keypas Option Description/Values range Defaut
name values

Pre-dispense | Quick, small prime to condition the No
tips before dispensing.

Flow Rate: | 96-tube & 192-tube manifolds: The 9
range is 3-11, 3 is slowest and 11 is

fastest.

Volume: | yL/tube dispensed range: HL/tube:
96-tube manifold: 50-3000 96 = 50
192-tube manifold: 25-3000 192 =25

Bottom wash | Bottom washing adds an initial wash | No
cycle to the specified number of
cycles. Fluid is simultaneously
dispensed and aspirated to create
cleaning turbulence (at the specified
height). The manifold descends to
aspirate again and ends with a final
dispense to fill the wells.

Rate: | Valid range is 3-11. The cell wash
rates, 1 CW and 2 CW, which use
low-flow tubing, are available but not
recommended. Cell wash options are
designed for gentle washing, while
bottom wash is designed for vigorous
washing.

Wash | 25-3000 pL/well dispense 250
Volume:

Positioning: | X- and Y- horizontal axes, Z- height
| (vertical) axis can be adjusted.
Repositioning the tubes to harder-to-
' reach areas of the wells may the
improve results.

MIDCYC Between
cycles
Shake To mix the contents of the plate. No
Duration | From one second to one hour. l 5 sec.
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SO Option Description/Values range AN
name values
Intensity Intensity | Variable cycles Medium
Slow through the other
Medium levels of intensity
Fast
Soak Delays wash for the duration to allow | No
fluids in the plate to steep or
incubate.
Duration From one second to one hour. 30
Home carrier | To-perform the shake orsoak inthe | No
home position or not. But, the plate
carrier is moved home when the total
duration of the shake and/or soak
exceeds 1 minute. The vacuum pump
is turned off in this scenario. Moving
the plate home prevents
contaminating it with drops from the
manifold.
Pre-dispense | To wet or condition the manifold No
between tubes between cycles, which is only
cycles needed after a long soak. Same
parameters as regular pre-dispense.
POST Post wash When all cycles are completed.
Final A final aspiration is performed to Yes
Aspirate completely evacuate the wells.
Same parameters as regular aspirate
step.
FORM Wash format | Manner of processing large-format Plate
plates
Sector Performs the entire wash step on one
sector of the plate before it moves to
the next sector.
Plate Performs each cycle to the entire
plate before it starts the next cycle.
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At the Name screen when you are creating or editing a protocol, you can enter up

to 16 alphanumeric characters to name the protocol:

« Press Shift + the number key for A-H, or scroll through the alphabet with the

Options key for A-Z.

« Press Shift +Options to reverse direction.

« Use the arrow keys < » on either side of the Options key to move the cursor

within the display.

. Press its Soft-key to add one of the four symbols (- % & _) in the display to the

protocol name.

. Press ENTER when you are finished to store the protocol name.

. If the name already exists, an Invalid Protocol Name message displays
and you must enter a unique name.

How to enter negative numbers (Keypad only)

Some protocol parameters, like Horizontal Dispense Position (X-axis), require

inputting a negative number to improve performance.

To enter a negative value:

1. Using the number pad, start at 00 (zero) and press Shift +Options to display

the minus sign.

2. Use the number pad to enter the desired value. The minus sign will remain,

making it a negative value.

How to copy a protocol

You can save significant time creating protocols by copying a protocol that shares
some of the same protocol parameters and then editing the copy to meet your needs.

LHC users: Open the protocol you want to copy and select File>Save As. Assign
unique file and protocol names to it. Consult the Help to learn more.
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Keypad users: —

1.

RUN:

SR U T i

Select DEFINE at the main menu.

Select Copy.

Choose the type of protocol you want to copy.

Use the Options key or enter the protocol number to select it.
Enter a unique name for the new protocol you are creating.

Select Yes to copy the protocol. Then, you can edit the protocol, as needed.

Running Predefined Protocols

BioTek provides numerous predefined protocols for maintaining the instrument
in top condition and for qualifying its performance. Review the Predefined
Protocols on page 42.

To run a defined protocol:

LHC Keypad ‘

R .
1. 'Y Select Open and locate the 1. At the main menu, press RUN.

405 LS folder. 2. Press Options to scroll to the

2. Open the 405 LS folder to access desired protocol or use the arrow
the more folders. Find the desired anel number keys o entenis

protocol for your instrument number.
model. 3. Press ENTER and follow the
prompts.

Important: Be sure to Customize the
Predefined Protocols on page 48

Creating Protocols: Washing, Aspirating and Dispensing Fluid

In addition to the quick routines available from the keypad’s main menu, you can
define and run protocols. Protocols offer more parameters, giving you the ability to
fine-tune instrument performance, and perform more complex processing.

Keypad Control

Find instructions for creating and modifying protocols using the keypad

beginning on page 33.
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Liquid Handling Control™ (LHC) Software

(s
2 Launch the LHC software to create or modify protocols, see page 46.
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Predefined Protocols Listing

Keypad Users: The protocol names onboard the washer do not include the W- prefix and

some protocols

include the model name, e.g. 405HT or 405Select, when appropriate.

Maintenance Protocols

Daily B

Maintenance DEseripon

W-DAY_ Simple one-step protocol to fully flush the system with water or

RINSE reagent to keep the manifold tubes clog-free. Defined for use with
Buffer A; 500 mL total volume.

W- Protocol designed to keep the manifold in a wetted condition

OVERNIGHT overnight or for a long downtime period; manifold tubes are

LOOP submerged in fluid for 4-hour intervals between primes in this
virtually endless Ioop Defined to use BufferA

W-RINSE_ Identical to W-DAY_RINSE with one addltlon the manifold tubes are

AND_SOAK | submerged and soaked for 5 minutes in the fluid.

Periodic Maintenance

W_
Decontaminate
DECON
(onboard)_
STEP1, STEP2,
STEP3

W-LONG_
SHUTDOWN
PURGE_WITH_
AIR (onboard)

W-CLEAN_w-
BUFFER
(LHC Only)

W-PRIME_
250/300

Two/three stage protocol to decontaminate the washer, first
flushing lines with disinfectant and then rinsing them with
deionized or distilled water. Buffer switching models flush and
then rinse all four lines. Manifold tubes are submerged and
soaked for 20 minutes during each pass. Prompts guide the user
through the process.

Helps implement the recommended procedure for preparing the
instrument for storage. This protocol includes prompts for
running disinfectant from Buffer A, then water from Buffer B,
and lastly, air through the system - remove bottle from Buffer C
valve.

Combines priming and AutoClean steps to clean and rinse the
manifold. For units with the Buffer Switching module it is defined
to obtain cleaning fluid from Buffer B, and rinse fluid from Buffer
A. Units without Buffer Switching are prompted to change fluids.

Simple prime routine; defined for Buffer valve A only. For LHC
only.
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Periodic Maintenance

PRIME_ALL _ Consecutively primes each of the Buffer Switching valves
BUFFRS beginning with D. Designed for use in the annual instrument
verification test of the Buffer Switching module.

QC (Quality Control) Protocols

Manifold-
Specific

96_DISP_ | Dispense precision test protocol for 96-tube wash manifold.
TEST

96_EVAC_ | Evacuation efficiency test protocol for 96-tube wash manifold.
TEST |

QC_192_ Dispense precision test protocol for 192-tube manifold.
DISP_TEST

QC_192_ Evacuation efficiency test protocol for 192-tube manifold.
EVAC_TEST

QC_96_ Vacuum filtration evacuation efficiency test for 96-well filter plates and
VAC30_ also recommended for use in maintenance procedures.

TEST

QC _384_ Vacuum filtration evacuation efficiency test for 384-well filter plates
VAC10_ and also recommended for use in maintenance procedures.

TEST

Predefined Sample Protocols

The "Sample" protocols are provided to facilitate learning. Some samples are model
specific.

Keypad Users: The protocol names onboard the washer do not include the W- prefix
and some protocols include the model name, e.g. 405HT or 405Select, when

appropriate.

Serial dilutions

P-96_ Peri-pump serial dilution protocol dispenses 20 pL to 240 pLin 20
DILUTION uL increments to each column of the plate. 20 pL to column 1; 40 pL
| to column 2; 60 pL to column 3; and so on till 240 pL to column 12.
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P-384_ | Serial dilution protocol dispenses 2 L to 94 pLin 2 pL increments

DILUTION to each column of the plate. 2 gL to column 1; 4 pL to column 2;
and so on till 94 L to column 24.

S-96_ | Syringe dispenser serial dilution protocol dispenses 240 pL to 20 pL

DILUTION \ in 20 pL increments to each column of the plate. 240 uL to column

1; 220 pL to column 2; 200 pL to column 3; and so on till 20 pL to
column 12. Defined for Syringe A.

S-384_ Serial dilution protocol dispenses 98 yL to 6 pL in 4 pL increments

DILUTION to each column of the plate. 98 L to column 1; 94 pL to column 2;
90 pL to column 3; and so on till 6 pL to column 24. Defined for
Syringe A.

Cell Wash

W&P-96_ Cell wash-dispense protocol uses the special low-flow tubing,

CELL_WASH optimal dispense and aspirate heights, and vacuum delay during
| the wash step. Following the wash, the Peri-pump dispenses 200 pL

 to each well.
W- | Cell wash protocol designed to minimize cell layer disturbance in
CELLWASH _ 96-well plates. Aspirate height increased to 50 steps (approx. 6.35

|
96 | mm above plate carrier) resulting in increased residual,
! approximately 100 pL.

W- Cell wash protocol designed to minimize disturbance to cells in
CELLWASH_ | 384-well plates. Aspirate height increased to 50 steps (approx.
384 ' 6.35 mm above plate carrier) will cause increased residual volume

' but help to preserve the cell monolayer.
Microplate Manufacturers

W- Standard wash protocols modified to best position the manifold
COSTAR tubes for dispensing and aspirating to Corning Costar flat-bottomed
Corning_ and round-bottomed wells.

FLAT

W_
COSTAR
Corning_
ROUND
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W:I\_IUNC_ Standard wash protoéols?odiﬁed to best position the manifold
384 tubes for dispensing and aspirating to Nunc® flat-bottomed wells,

' round-bottomed wells, and 384-well plates.
W-NUNC_ ‘

FLAT

W-NUNC_
ROUND

Bead Assays - Biomagnetic Separation and Bottom Filtration

W-Luminex_ | Biomagnetic separation wash protocols designed for optimal bead
MAG_plate_ recovery in 96-well round- or flat-bottomed plates and 384-well
96 plates when using BioTek's Flat magnets. Begins by soaking the
| plate for 1 minute to let the beads settle at the bottom of the wells,
| then performs a 2 cycle wash with 30 second soaks between cycles.
W-Luminex_ | Recommendation: Determine Magnet Height Offset on page 65 and
MAG_384 apply it for the plate you are using, especially when using 384-well
plates.

W-Luminex_ | Vacuum filtration wash protocols for Luminex® xMap polystyrene
VAC_96 bead assays using filter-bottom plates, 96- and 384-well. Protocol

' begins with a 5 second bottom aspiration, followed by a 200 pL
W-Luminex_ | dispense for 96-well plates and 75 pL dispense for 384-well, and a
VAC_384 ' two cycle 200/75 pL wash.
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~ Using LHC to Control the 405™ Washer

BioTek's Liquid Handling Control (LHC) software offers another way to design
protocols and control the instrument. The washer must be attached to and
communicating with your personal computer (PC) for the LHC to function.

Predefined Protocols

BioTek provides predefined protocols for maintenance routines, instrument
qualification, and other purposes like serial dilutions.

RS
Click the Open button and locate the 405 LS folder to open a predefined
protocol. Learn how to Customize the Predefined Protocols on page 48.

4 Standard Wash.LHC - Liguid Handling Caontrol 2.11
Fle Edit Tools Help

AN % IS

Instrurnert [ BieStack Control

Marme: 405TS 1 Port I [] Disable Editing
FPat:  COM1

Sellings. 96-tube Dual Washer manifold Enruu | | Yalidate

Buifer Switching (washer)

Ultrasonic Advantage | L Run
Cell Washing
Plate Type: Add Step [Z] E
96 Well Plate v Piotocol Steps

l Delay J [ W-Wash J\.\?’{."\A-"-"-A-'ash 300 pL of buffer A for 3 cycles

<end of steps>

Protocol Name: (on-board name)
Standard \Waszh

From File... J LW-Aspirale

l

l ]

User Protocal ersian: Archive Revision: 1 AT ] L AN ]
| l |

Il 1 _ Loop | | ‘w-Prime
Protocol Comments: ! - [W-ﬁ.utotlean |

| Shake/Saak |

' Step Details

1 Instrument Settings: Click the Name link and select your instrument.
m405 Steps on the facing page

E Define a Protocol: select Help>Help Topics to learn how.
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Click the action button and define the parameters to add that step to the protocol:

| W-wash W- for steps performed by the Washer.

W-Aspirate |

\ W-Dispenze

I W-Prime _
I ‘Ww-AutaClean |

Shake/Soak I Shake and soak

Each step is executed sequentially. Specific sequences are required when using the
BioStack. Any errors will be identified when you press the Validate button.

Communications Port

Click the Port link in the main screen

The LHC needs to know the COM Port - Communications Port: USB or Serial
component on the instrument used to connect the washer-dispenser to the computer.

« Make sure the 405 LS is connected to the computer, turned on, and not
busy.

« Learn more About COM Ports in the LHC Installation Guide or select
Help>Help Topics.

Click Test Communications after entering the number to verify its accuracy. The
LHC will display a message.
If communication is unsuccessful:

. Check the cabling: make sure you're using a new/undamaged BioTek-supplied
cable and it is properly inserted into the instrument's USB or serial port.

« Turn on the washer-dispenser: make sure the instrument is on and not busy
processing a plate, running AutoPrime, or performing a system test, for example.

« Retry: contact BioTek TAC if you are still unable to establish communication
between the instrument and the PC.
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—LHC Users Only: Customize the Predefined Protocols —

BioTek provides predefined protocols for maintenance routines and instrument
qualification tests. You can quickly customize the protocols for regular use.

. The LHC keeps track of the last-used COM port for an instrument type. For example,
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406
is used, the LHC applies the same COM port setting. You can disable this feature by defining
your Ports preference: select Tools>Preferences>Ports.

To correct the COM port for the current protocol, click the Port link and use the drop-down
list to select the correct value. The LHC stores the COM port value in the protocol file.

With the 405 LS connected to and communicating with the host computer (i.e.
make sure the instrument is turned on and not busy):

1. ' 5 Click the Open button, locate the 405 LS folder and click Open.
2. Open the Maintenance or other folder and select the desired protocol.

3. Pot Change the COM port if necessary: click Port and enter the correct value
or select from the drop-down list.

4, M e Settings, which opens the Instrument Settings dialog.
5. Under Get settings from: click the instrument link.
6. |__vaidte | Click validate.

A "Validation successful" message is displayed unless the protocol cannot be
run on your instrument.

7. H Save the protocol.

Upload-Download Protocols (LHC Only)

The LHC lets you transfer protocols from your computer to your instrument and
back again.

Limitation: Protocols must contain only instrument-supported action steps to qualify
for download. That is, the protocol cannot contain any of the LHC provided steps
like Delay and Loop (buttons in the left column of the Add Step box in the main
view). And, a Protocol Name is required.

« The instrument's main menu must be displayed for the LHC to
communicate with it.
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1. Select Tools>Transfer Protocols.

2. Make sure the desired protocols are displayed: check the Protocol Folder path for
This computer. Refresh the list of protocols onboard the Instrument by clicking
the Settings link.

3. Highlight one or more protocols in a display box. (Hold the Ctrl or Shift key to
simultaneously select multiple files.)

4. Optionally, at the top left corner of the screen, choose to Disable Editing of
transferred protocols to lock the protocols from editing or deleting when they are
onboard the instrument.

5. Click the applicable Upload or Download button.

The LHC will confirm the transfer or prompt you for more information. When the

transfer is complete, you can manipulate the files as you normally would in their new

location.
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~ Verify Performance

« LHC Required for "Q" models: you must use BioTek's Liquid
Handling Control (LHC) software to run the Verify™ Technology clog
detection feature.

ools>Instrument Utilities>Verify Manifold>Run a New Test |

BioTek's Verify™ Technology quickly detects clogged aspirate or dispense tubes.

Important! Before running the test:
Make sure the 405 LS is primed and ready to run:
« Fully prime the tubing/system, e.g. run Day Rinse.
« If necessary, empty waste vessel and tighten waste bottle cap.

Prepare to run the Verify test:
o Fill the supply vessel with at least 100 mL dH20 or DI water or buffer solution®.

Run the Verify test:

LHC

1. Select Tools>Instrument Utilities>Verify Manifold and click Run a new
Test.

. Buffer: Select the bottle to use, if applicable.

« Prime: optionally, prime the manifold tubes to correct for evaporation loss.
40 mL of fluid is dispensed.

« %CV Threshold: optionally, change the %CV to match your lab's standard
for QC tests: 5-15%. The default value of 5% is recommended.

2. Press Start to run the test.

3. Assess the results: Verify Results. (Refer to the operator's manual for a complete
description of the Verify Technology process and procedure.)

B
&0 Do not discard the Verify Test Plate. Reuse it for as long as possible.

1po not use highly viscous fluids or wash buffers that are prone to leave significant residue on the plate.
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Frequency:

5 Minutes: Gain complete confidence that your plates will be processed correctly by
spending five minutes to run the Verify test before running your assay!

Develop a schedule for running the Verify routine based on the type of wash buffer
you are using, how frequently you use the washer, and your maintenance habits:

. Daily: When using PBS, protein, and other fluids that easily crystallize and
harden, potentially clogging the tubes, run the Verify routine every day and/or
after prolonged downtimes to ensure the tubes are not clogged.

« Weekly: When using TRIS and other low-salt buffers and when adhering to the
recommended maintenance schedule, you can confidently run the Verify routine
less frequently, e.g. before new assay runs.

- Replace the Verify Test Plate (according to the prescribed procedure) if
it is damaged, scratched, warped, etc.

Manage Test Results

g
- — .
Test : v  View Reportfilg

a8

. i 4 2
S 3 N LR [ PR =y g
Siai ko d 4 S _-f-“ A n il s, o

Immediately after a test is run, its results are displayed. The test data file is named
with the date and time. You can view previous results using the drop-down list of
tests. The most recent test results are at the top of the list.

View Report file: to open a text file of the current test results. Report file names are
appended with Passed/Failed results.

Configure settings: to specify a text file folder. See Configure Verify Test Settings
for other useful info.
Handling the Verify Test Plate

The Verify Test Plate ships in its own special box. The plate is labeled with the serial
number of the 405 LS that has been calibrated for its use.
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Matching serial number

Verify Test Plate

Important guidelines:

Always put the plate on the carrier with well A1 |
I

in the back, left corner of the carrier.

Clean the plate after each use if you are using
wash buffer to run the test.

Fully dry the plate after each use and before
putting it back in its foam-lined box.

Inspect the plate regularly for damage, e.g.
scratches, chips, warping.

Replace the plate when it is damaged. See
Replacement Procedure for Verify Test Plate
in the operator's manual.

« Well Al is opposite the
chamfered or beveled
edges.

"%« The plate is labeled with

the washer's serial
number.

« When the plate is on the
carrier in the proper
orientation, the "Front"
label is visible.
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Operating with the BioStack

If you purchased BioTek’s BioStack Microplate Stacker to operate with the 405 LS,
here is some important information about running it:

Keypad Control:

. The Quick Wash option does not function with the BioStack, i.e. the BioStack will
not deliver a plate. You must create a protocol to process plates using the
BioStack.

. You can use the Quick Prime option. This is recommended especially prior to
processing plates, to remove air from the tubing.

« To process plates with lids (a BioStack4 feature), LHC must control the BioStack.

LHC Control:

. LHC users: connect both the BioStack and the 405 LS to the computer and control
them with the LHC.

. Design protocols that integrate BioStack controls with 405 LS steps. LHC
protocols must contain a BioStack loop.

. Inthe LHC, select Help>Tutorials, click Sections in the toolbar for a drop-down
menu, select Controlling the Bio-Stack with LHC. It only takes a couple
minutes to complete this interactive demo. It is a great way to learn about the
special BioStack features offered with the LHC.

Install and Align the BioStack:

1. Set up the BioStack according to instructions in your BioStack Operator’'s Manual
to interact with the 405 LS. Connect the BioStack to the:

« Host computer (PC) when using the LHC to control the 405 LS.
« 405 LS when using the keypad for instrument control.

2. Align the BioStack’s gripper with the 405 LS'’s plate carrier:

LHC: Keypad: |
1. Select Tools> BioStack 1. Press Setup Menu. ‘
Utilities. 2. Select >
2. Use the Alignment Utility. 3. Select BIOSTK
Click the Help button for 4. Select ALIGN.

detailed instructions.

3. Set the BioStack operating mode:
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|

LHC: Keypad:
[¥] BioStack 1. Press Setup Menu.
| Pot: COM1 2. Select >
[] Use Lids 3. Select BIOSTK.
| Process: 10 plates 4. Select CONF
f Flate stacked heiaht: default
| 5. Select BIOSTACK.
| Fill the BioStack checkbox in the main Important: When using LHC to control the
view to enable the BioStack action 405 LS and the BioStack, the instrument's
buttons and use them to design a BioStack configuration setting must be set
protocol that delivers and retrieves to MANUAL, not "BIOSTACK."
plates.

« To Restack or not? Yes: to keep plates in the same order. No: to save
time when the plate sequence is unimportant.

4. Verify the setup: perform a protocol with 1 or 2 plates.

At the start of the day, power up the BioStack first, and then the 405 LS. BIOSTACK2WR:
Lift the BioStack’s gripper before turning it on.

Robotics integrators: CAD drawings of the physical dimensions of the 405 LS are
available upon request. Contact BioTek customer service.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You
can use USB to connect the 405 LS to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

L ot
i ot i

Keypad Control: When the BioStack is connected to your 405 LS, you are
controlling both instruments using the keypad. Before connecting the 405 LS to
your computer to download basecode or for other reasons, you must first
disconnect the BioStack from the 405 LS and change the Instrument Setting for the

BioStack: Press Setup Menu> —> > BIOSTK> CONF>MANUAL.
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Cell Wash

« Not all 405 LS models support cell wash assays. The dual 96-tube wash
manifold must be installed.

See how to Define a Cell Wash Protocol on the next page.

Low-flow Fluid Path

The 405 LS supports cell-based assays that require the addition and removal of buffer
solution without disrupting the cells in the wells of the microplate. Cells are often
dislodged when fluid is dispensed at too high a pressure and lost during subsequent
aspiration of the fluid from the well unless counter measures are taken. The 405 LS is
equipped with a low-flow fluid path that provides a "cell wash" alternative for cell-
based assays.

Standard Flow Rates 3-11 Selected

Fluid/Flow

Fluld '
e Sensor f \‘--\‘
_. | 7 6
i
L

F
£ Dispense Valve

Inlet Filter r— A
“Low Flow Line" Smaller diameter lubing

Cell Wash Flow Rates 1-2 Selected

Closed Fluid Control Valve

FluidiFlow

| Fluid in Sensar |

|
_ ) |

\
Inlet Fliter f————

“Low Flow Line" Smaller diameter tubing

,f'-u
Dispense Valve
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— The low-flow tubing is used during a wash step when the Flow Rate is set to 1 or -
2. It dispenses fluid to the wells slowly enough to avoid damaging the cells. Note
that the low flow line is always open, i.e. some fluid flows through the tubing
during normal dispenses. For this reason, priming the low flow tubing is
recommended for all Prime steps.

Additional Techniques

Delay Aspiration: Also critical to cell-based assays is delaying aspiration to allow
the slower dispense process to finish before beginning fluid removal from the well.
This option, offered as part of the dispense step, is called Delay Start of Vacuum.

Adjust the Aspirate Travel Rate and Aspirate Height: when defining the aspirate
step select one of the specially designed travel rates that minimize turbulence in

the wells. Increase the aspirate height to leave more residual fluid in the wells to
protect the cell layer. Also, consider using a secondary aspiration.

Adjust the Dispense Flow Rate, Height and Position: when defining the dispense
step be sure to select one of the special Flow Rates that trigger use of the low-flow
tubing, 1 or 2 CW. Also reposition the dispense tubes to aim the fluid at the side of
the wells to further minimize turbulence. See Cell Wash Strategies on the facing page.

Define a Cell Wash Protocol

Adjust the volumes recommended in this procedure to meet your specific needs.

1. " Create a new protocol.

2. [ WPime | Add a Prime step, especially when the lines are empty or when
changing fluids.

3, [ Wwssh | Aqq 2 wash step and define it as you normally would, except

with these special parameters:
« Set the Aspiration Travel Rate to 6 CW and the Delay to 0.
» Set the Dispense Flow Rate to 1 or 2.

. Select the Dispense Advanced Options link and enable the Delay start of
Vacuum until sufficient fluid has been dispensed. For small dispense volumes,
BioTek recommends setting the delay volume to equal your dispense volume.

« Reposition the dispense tubes to aim fluid at the side of the wells to reduce
turbulence and change the aspirate height to increase the amount of residual
fluid left in the well to protect the cell layer. See Cell Wash Strategies on the facing

page.
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Be sure to check the parameters for Final Aspiration.

Cell Wash Strategies

To give you a starting point for optimizing your own assays, here are some
recommendations for improving your cell wash assays:

| g
.,{[,lespense Tube
V4
Aspiration Tube o
[L e, Movingthe
dispense tube to
aim the fluid
Eeet?nﬁ stream atthe side
may of the well
dislodae / Fluid prevents damage
cells. Shigan tothe cells.

Distodged

2

Repositioning the dispense and aspirate tubes helps minimize turbulence in the
wells, preserving more cells.
Using a standard 96-well Corning Costar plate, best results were achieved with these

values:

Dispense Step Settings: Washer Dispense Options

Z - height = 120 steps
X - horizontal position = -45 Positioning:
Y - horizontal position = 0

Z| 1205 15.24 mm above carrier

pd
.J-OX % | -45 2 2.06 mm left of center
YO v

b A
;| 0% centerof wel
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Aspirate Step Settings: Washer Aspirate Options

Z = 46 steps
X=35 Positiohing:
Y=0 Z Z: 462 5.84 mm above carier
Secondary Aspirate: .J—DX X, 3B3 | 1.60 mm right of center
Z = 80 steps Y B :
X = -45 Y:| 0% centerof well
Y=0 .
About 40 uL/weII residual Perform Secondary Aspirate
fluid is retained using these Z:| 80% 10.16 mm above carrier
values. X:| -45 % | 2.06 mm left of center

Y:| 02| centerof wel

For loosely adherent cells, the best performance was seen by increasing the aspirate
height and using both a standard and secondary (or crosswise) aspiration. Moving the
aspirate tubes from one side of the well to the other prevents a fluid stream from forming
and dislodging the cells. Increased residual in the well means increased cell retention.

Best practice:

« Use the Align toolAdjust Utility to determine the optimal X, Y, and Z axis
adjustments needed to best position the manifold above the wells during the
wash routine.

« Test the protocol settings by running the protocol using only water and an
empty plate before actually running your assay to make sure the fluid stream
hits the wells as desired.

Delay Aspiration or Vacuum-0On Volume Control

LHC: Open the Wash or Dispense Step>Advanced Options [

Keypad: Edit the Wash or Dispense Step>Press Enter till Vacuum Delay Vol:

Delay start of Yacuum far cell washing until

Volume dispensed: f1D & pliwel

During regular plate washing, aspiration and dispensing occurs simultaneously.
This allows "overflow" dispensing, because the fluid is aspirated before
overflowing the plate. But, the low-flow tubing used in cell wash protocols
dispenses fluid so slowly that aspiration must be delayed to allow the fluid to
reach the well.
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Aspirate |

/ Dispense AsPirate | / Dispense
tube

[ tbe tube / tbe

No Delay With Delay

Use this control to turn on the vacuum pump and begin aspiration only after the
specified volume is dispensed. For cell wash assays, specify at least 10 uL./well. For
small dispense volumes or to disable aspiration for the entire dispense duration, set
the vacuum-on volume to equal your dispense volume. Refer also to application
notes on the BioTek web site for more information (www.biotek.com).
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Biomagnetic Separation - Magnetic Bead Assays

The microplate carrier supports placement of a magnet under the microplate. The
magnet induces magnetic beads to settle at the bottom of the wells to help retain
them during a wash protocol’s aspirate cycle.

The 405 LS supports standard microplates and these magnets available for
purchase from BioTek:

Plate Type Magnet PN

96-well 96 Flat Magnet | 7103016

96 Ring Magnet | 7102216

384-well 384 Flat Magnet | 7103017

384 Ring Magnet | 7102215

You can use a different magnet if it fits in the carrier and accommodates your
plates. Contact BioTek TAC or visit the Customer Resource Center at
www.biotek.com to obtain a drawing of the carrier with its dimensions.

I
) Persons with pacemakers/implants should avoid direct contact.
Keep all magnetic media, watches, and sensitive electronic devices away from
the magnets. Credit cards, tapes, and disks can be erased in the presence of a
magnetic field. Bodily harm [pinching of hands and skin] can result if magnets
are not handled correctly. Maintain distance between two or more magnets.

Handling and Cleaning the Magnets

For best magnet strength and bead retention, the bottom of the microplate must be
as close to the magnet as possible. We recommend using flat-bottom plates with
minimal support “webbing” between the sides of the outer wells and the plate
skirts.

Handle the magnets with care. Avoid direct contact with the magnet material. Keep
loose ferrous material away and do not attempt to disassemble.

The magnet should be stored in a cool, dry environment and should be cleaned
with a damp cloth and mild detergent when exposed to harsh solvents. Do not
autoclave.

To install the magnet in the proper orientation:

« Flat magnet: place in the plate carrier so the text on the side of the magnet is
readable;

405™ Microplate Washer LS



Biomagnetic Separation - Magnetic Bead Assays| 61

. Ring magnet: place in the plate carrier with the small round magnets visible,
facing upwards.
Realign the BioStack with the Magnet Installed

Using the magnet increases the effective height of the carrier surface (generally by at
least 71 mm). This shift in the plate position requires a comparable adjustment to the
BioStack’s gripper movement. Realign the BioStack before using it with the magnetic
bead assays.

Refer to the BioStack Operator’s Manual for detailed instructions of the alignment
procedure. To help get you started:

1. Place the magnet in the carrier and a microplate on top of it.

2. Launch the BioStack Alignment Utility:

| LHC Keypad |
‘Tools> BioStack Utilities> Alignment Utility ‘ SETUP >—- BIOSTK > ALIGN

3. HOME the BioStack and Begin Realignment.

4. Lower the claw until a 0.050” (1.3 mm) gap between the bottom of the plate and
the top of the gripper fingers is achieved and save the gripper position.

5. Put the microplate in the input stack and Verify the alignment.

Remember to realign the BioStack for non-bead assays, when applicable.

Perform Magnetic Bead Assays

For the best results when performing biomagnetic separation assays:
« Use the Manifold Stop Screw Adjustment Kit on page 66, if necessary.
. Realign the BioStack with the Magnet Installed on page 61
« Change the Magnet Height Offset on page 64
« Optimize Magnetic Bead Protocols below

Optimize Magnetic Bead Protocols

Here are some suggestions to consider for optimizing your magnetic bead assays:

. Plate Type: Flat-bottom plates are recommended for magnetic bead assays
because more of their well surface sits closer to the magnet, resulting in
increased magnet strength, than with other plate formats. If you must use round-
bottom plates, increase the between-cycle soak time to improve bead separation
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during processing.—— = = -

« Magnet Adapter Height Offset: Deploy this offset to increase the Z-axis or
height setting in all processing options to accommodate the increased height of
the magnet. See Determine Magnet Height Offset on page 65. Use of this feature
may eliminate the need to "Adjust the Aspirate height" described below.

« Shake/Soak Step: Begin the protocol with a delay to let the magnetic beads
settle. Also, specify a mid-cycle soak to let the beads settle after fluid is
dispensed to the plate, e.g. include a 60 second soak before and between
cycles.

Include a 1 second Shake in the first step to best position the plate.

« 6CW Aspirate Travel Rate: select 6CW for the aspirate travel rate. The CW
travel rates are designed to minimize disruption to cell layers on the bottom of
the well. The same principle applies to magnetic bead assays.

« Adjust the Aspirate height: increase the aspirate height setting (Z-axis) which
will increase the residual fluid in the wells but also preserve the beads. Good
results were obtained when keeping the aspirate height around 18.0 mm above
the plate carrier for all but a last Final Aspirate (disabled between cycles).

« Adjust the Aspirate position: When using Flat Magnets below, position the
aspirate tubes near the sides of the wells (X-axis), if possible, to improve bead
retention.

. As always, before running assays, we recommend testing new protocols using
deionized or distilled water and a little Tween® 20 with the desired microplate
and a magnet installed.

Flat Magnets
Use this information about the flat magnets to fine-tune wash protocol settings:

96F Magnet | 7103016

384F Magnet I 7103017

The 96- and 384-well magnets are structured differently. Their force fields traverse
the magnet in opposite directions. Magnetic beads in the wells will be drawn to the
center. For the best bead retention, reposition the aspirate tubes in the proper axis:
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96-well Flat Magnet PN 7103016

The magnetic force (approx. 6800 Gauss)
is distributed in a horizontal pattern,
row-wise, across the plate. Magnetic
beads are pulled to the center, across the
well in flat-bottom plates and to the
button in round-bottom plates.
Increasing the aspirate height to increase
the amount of residual in the well may
improve performance.

Aspirate Settings:

Adjust the Y Position to align the
aspirate tubes near the well walls, if
available. Increase the Aspirate Height
(Z axis), leaving more residual volume
in the wells.

384-well Flat Magnet PN 7103017

The magnetic force (approx. 4300 Gauss)
is distributed in a vertical pattern,
column-wise, across the plate.

Adjust the X Position to align the
aspirate tubes away from the center of
the well, near the well walls.

Ring Magnets
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Use this information about the VP magnets to fine-tune wash protocol settings:

96 Ring Magnet ‘ 7102216

384 Ring Magnet ‘ 7102215
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96 Ring Magnet
PN: 7102216

This magnetic bead
separator uses 329 of VP’s
52 MGO magnets (7094
Gauss). The magnets are ' @] magnets
arranged around each well, il around
pulling the magnetic beads
to the bottoms and edges of
the wells. Aspirate from the
center of the well (the
default position), when
using this magnet.

384 Ring Magnet “?;}, |i:.'; Magnetic beads
PN: 7102215 o S are pulled to
This magnetic bead i“?"”:“l ezdogrj-leeS r?r]lc;
separator uses 425 of VP’s o

52 MGO magnets (6994
Gauss). The magnets are
aligned with the
intersections of the wells,
pulling the magnetic beads
to the bottoms and edges of
the wells. Every well is
circled by 4 magnets.

| each well

Aspirate from the center of the well (the default
position), when using this magnet.

Magnet Height Offset

When performing magnetic bead assays/biomagnetic separation, this offset setting
is a real time saver. It increases the height or Z-axis for all processing options to
accommodate the increased height of the plate when the magnet is installed.

This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Wash (without adjustments)
when the magnet is used. It applies the specified height value as an offset to all
relevant steps.

Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the 405
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LS, i.e. the vessel's geometry permits the manifold tips to successfully address its wells, this

setting can be used to simplify protocol development.

For the best results, measure the height of the plate you are using with the magnet. BioTek

has determined that Nunc flat bottom plates are about 3 mm taller than a similar Corning
plate, for example.

The "In use" checkbox/option lets you specify and retain a height setting. Set the
value once and then use the control to switch it on and off: fill the checkbox (keypad
users: say Yes) when using a magnet, empty the checkbox (keypad: No) to disable the

offset.
LHC Keypad
1. Tools> Instrument Utilities> General 1. SETUP > more>
2. Fill the In use checkbox and set the Magnet MAGNETHT
Adapter height to the correct offset. 2. Select YES.
3. Click the Send link. 3. Enter the desired offset

Determine Magnet Height Offset

value and press Enter.

Use calipers for the best results or another measuring device.

Explicit instructions:

1. Remove the carrier from the washer.

Quick instructions:

1. Measure the combined height of the
plate, magnet, and carrier in
millimeters.

2. Measure the plate and the carrier.

3. Calculate the offset: (plate + magnet +
carrier) - (plate + carrier) = Magnet
Height Offset

2. Put a magnet in the carrier and the type of plate you will be using on top of it.
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3. Measure the distance from the bottom of the carrierto the topof the plate in—
millimeters (mm).

4. Remove the magnet, and measure the plate and carrier combined.
5. Subtract the plate and carrier measurement from the measurement value of the
total combined elements. This is the offset value to use.
Example:
24.6 mm = 96-well Corning microplate + 96-well flat magnet + plate carrier
- 22.7 mm = 96-well Corning microplate and plate carrier

1.9 mm = Magnet Height Offset

Manifold Stop Screw Adjustment Kit

For Magnetic Bead Assays and 384-Well PCR Plate Processing
To successfully perform these assays, 405 LS Select and HT models may need to
adjust the height of the manifold stop screw. The adjustment kit, PN 1170011, is
shipped with instruments with a dual manifold.

The manifold stop screw prevents the
bottom manifold from touching the

microplate during operation. Sometimes " [ Manifold stop T
the screw installed at the factory is too tall | screw
or too short to permit desired processing:

« ataller screw is needed to support a
magnet under the plate for magnetic
bead assays

« ashorter screw is needed to support
processing of 384-well PCR plates that
have a very low profile

Two stop screws can reside in the plate

carrier, making it easier to swap between
them.

Kit Contents:
« Screw height measurement tool (jig)

« Two stop screws with adjustable nuts ‘ﬁ
and lock washer ;

o 5/32" Allen (hex) wrench
« Two wrenches - 5/16" and 3/8"
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Remove the carrier to perform most of these steps but always perform the measurement
steps with the plate carrier installed correctly on the 405 LS.

1. In the carrier's empty hole,
insert the taller stop screw
when using a magnet or the
shorter screw when using PCR ;=
plates.

2. Put the magnet and :
microplate or the 384- e -
PCR plate in the carrier on the = i
instrument. Place the height-
measurement tool (or jig) on
top of the microplate, with the

notched end above the screw.

3. Hold the jig level on top of
the microplate and raise or
lower the stop screw so its
head touches the bottom of
the notch.

4. Set the jig aside. Using your
fingers, hold the stop screw in
place and screw the bottom
nut down until it touches the
microplate carrier.

5. Using the two supplied
wrenches, tighten the bottom
nut to secure the screw, then
tighten the top nut to fully
compress the washer between
them. This will lock the nuts
in place and allow you to
easily remove/replace the
screw without affecting its
height setting.

6. Verify the height with the jig and repeat steps 3-6 if necessary.
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Vacuum Filtration for Filter Plate Assays

With the optional vacuum filtration accessory kit, you can process most standard-
size filter-bottom microplates.

« Install the side bracket
« Set up the Vacuum Filtration module
« Install Vacuum Filtration Plate Carrier on page 71

Take advantage of the sample vacuum filtration protocols shipped onboard the 405 LS.
Copy W-Luminex_Vac_96, for example, and modify the parameters to suit your assay
requirements.

Recommendations for best performance:

Here are some guidelines to achieve the best performance of your filter plate
assays:

« Do not use dry filter plates. If dry plates are required by the assay kit
instructions, turn off the Vacuum Filtration sensor to avoid process
interruptions.

. Shake the plate to suspend the beads before aspiration. Enable the wash

cycle option to shake the plate after the dispense and before aspiration. Also
consider creating a multi-step protocol that begins by shaking the plate.

« Experiment with the two parameters, aspiration time and vacuum level, to
determine the best combination of settings for your assay. Start with a brief
time period and low vacuum to avoid lodging the beads in the filter material.

. Maintain consistent vacuum during the process with a tight seal:
. Use new or defect-free filter plates and make sure they are seated
perfectly in the carrier;

. Make sure all tubing is connected correctly, and leak-free.

Expect to spend some time experimenting with different pressure settings. Follow
the filter plate manufacturer's recommendations, if available. Generally, bead
assays prefer low pressure and DNA separation assays prefer higher pressure. The
best performance in tests at BioTek were seen when the pressure was set to 2.5

inHg.
Create a Vacuum Filtration Protocol

You may want to begin the protocol with a Shake step to suspend the beads.
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LHC: Keypad:

1. At the main menu, select
DEFINE>CREATE and assign
2. Select the plate type. a unique name to the protocol.

1. Click o (or select File>New).

3. Specify a Protocol Name. 2. Select the plate type.
4. Click | WWesh ] 3. Select ADD>WASHR>WASH
5. Click Show Wash Options 4. Select ASPIR>VAC
6. Fill the checkbox for Vacuum Filtration 5. Specify the duration to apply
and specify the vacuum duration, Time. vacuum.
Optionally, do the same for the Final
Aspirate.

Wash Step 3]l 6. Select OPTS>MIDCYC and
add a Shake duration to
follow each dispense to
suspend the beads before
applying the vacuum.

[[] Pre-dispense before washing
[ Bottom Wash before first cycle

Number of Wash Cycles: 3 &

W/aih Cycle efirion

Azpirale Dispense 7. Select OPTS> POST to either
(4] Vacuum Fiteation Bulies disable the Final Aspirate or
Volume: 250 | uL/wel make sure it is defined for
Time: 30 % | sec FlowRate: 68 2 vacuum filtration.
Advancad options Advarced epliong . .
8. Experiment with other
Shake/Soak aftes dispense Defintion parameters, like number of
O Pre-dispense between cycles cycles, to optimize the protocol
for your assay.
[] Final Aspirate y y

\ oK I l Cancel I | Help ]

7. Fill the checkbox for Shake/Soak and
specify the shake duration.

Experiment with different settings to determine the optimal parameters to meet your
goals.

. Important: Be sure to change the Plate Carrier setting to match the
installed carrier.

Remember to specify the type of aspiration to perform in a Final Aspirate. Keypad users:
select OPTS>POST at the Wash Step Parameters menu.
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Control the Vacuum Level

Vent plugs stored on side of carrier

Change the vent plug to control the vacuum level

The vacuum filtration plate carrier has a vent and ships with four vent plugs to
vary the vacuum levels:

Plug Vent Diameter Vacuum Level | mmHg | kPa
No plug 0.067” (1.70 mm) | Lowest -32 -4.3
Beige with hole | 0.047” (1.19 mm) | Low -118 | -15.7
Gray 0.032” (0.81 mm) | Medium -187 | -24.9
Black 0.020 (0.51 mm) | High -382 | -50.9
Beige (solid) 0.00 Highest -567 | -75.5

Leave the vent open for the least amount of vacuum. Insert one of the plugs to
increase vacuum.

« Vacuum pressure is affected by several factors like relative humidity,
barometric pressure, and mechanical tolerances, as well as, filter plate
pore size

Testing at BioTek confirmed expectations: small pore filter plates and highly
viscous fluids require increased vacuum and/or longer aspiration durations to
evacuate the wells.
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Rigid tubing
connectorin
bracket

Vacuum Filtration Plate Carrier (and bracket for holding tubing)
1. Locate the longest length of tubing shipped with the module. It is made from two
tubes joined by a rigid connector.
2. Connect the shorter end to the special plate carrier for vacuum filtration.

3. Connect the longer end to the control module port labeled To Vacuum Filtration
Carrier.

4. Tuck the rigid connector into the bracket you installed on the side of the
instrument.

5. Change the instrument setting:

LHC | Keypad
1. Select Tools> | 1. Press Setup Menu >
Instrument Utilities. MORE > CARR
2. For Plate Carrier 2. Select VAC.
Selection, select Vacuum
Filtration.

Note: Make sure Vacuum Filtration is "enabled" to select the special plate carrier: Setup
Menu> = >ADVANC>VACFIL
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- Important: Always set the carrier selection to match the installed hardware, regardless
of the type of plate processing you are doing. You can perform a regular wash (non-filter
plates) using the vacuum filtration carrier.

Changing the Instrument's Settings

About the Onboard Settings

The instrument's onboard settings dictate its behavior. Certain settings, like Plate
Clearance, can improve performance. Other settings are critical to its performance.
For example, the manifold setting must match the installed manifold type.

LHC users: do not confuse the LHC's Target Instrument Settings assigned to each
protocol with the onboard settings! Review the Help topic: LHC Protocols Explained to learn
the distinctions.

To change the onboard settings:

| LHC ‘ Keypad

1. Select Tools>Instrument 1. Press the Setup Menu key (in the
Utilities center of the keypad).

2. Choose the applicable tab and | 2. Select the applicable device and the
modify settings as desired. setting you want to change.

3. Click Send after changing a « Alternatively, select UTILS at the
setting to update the main menu for AutoPrime, the
instrument. Adjust Utility and system tests.

Washer Settings

Manifold Selection
After physically changing the manifold, tell the 405 LS which manifold is installed:

« 96-tube: single manifold for 96-well plates only or dual manifolds to process
96- and 384-well plates.

o 192-tube: only 384-well plates.
o 128-tube: only 1536-well plates.

Magnet Adapter Height Offset

When performing magnetic bead assays/biomagnetic separation, this offset setting
is a real time saver. It increases the height or Z-axis for all processing options to
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accommodate the increased height of the plate when the magnet is installed. -
This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Wash (without adjustments)
when the magnet is used. It applies the specified height value as an offset to all
relevant steps.

. Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the 405 LS,
i.e. the vessel's geometry permits the manifold tips to successfully address its wells, this
setting can be used to simplify protocol development.

Sensors Enabled
. Important: The washer must be primed, tubes filled, priorto a run.

. These sensors cannot detect the depletion of fluid in the supply vessel during a
protocol step. Fill the supply bottle(s) with sufficient fluid to fully prime the
system and complete the protocol.

Fluid Detection: measures the fluid level at the beginning and completion of a
wash cycle, dispense and AutoClean step. An error before the run suggests
insufficient fluid to begin. An error at the end of the run may indicate that less
volume than specified was dispensed.

Flow Detection: monitors fluid flow during the run and issues a warning if the
pump is interrupted. An error indicates a problem with the pump.

Vacuum Detection: built into the vacuum filtration module, this sensor detects
errors in the setup of the vacuum filtration system, including disconnected tubing,
loose bottle cap, missing filter plate, non-functioning internal vacuum pump and
extremely low vacuum. This sensor is disabled by default.

Plate Detection: washers with Verify™ Technology offer this sensor to detect the
presence of a microplate on the plate carrier before every protocol run. BioStack
users: the sensor checks for the first plate in the stack only.

BioTek recommends keeping the detection systems activated. Exceptions:

. When vacuum filtration assays need to be performed at very low vacuum levels,
e.g. no plug, but the washer displays an error, deactivate the sensor: LHC - "Filter
Vacuum" or Keypad - "Vac Fil".

« When running the system using air instead of fluid to dry out the components
before shipping or long-term storage, if error messages interrupt the procedure,
deactivate the fluid and flow sensors.
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——CW+ Control

This setting is applicable only to cell wash assays that use dispense flow rates 1
CW and 2 CW. Generally, the optimal instrument configuration for cell wash assays
includes installation of the CW + Dispense Manifold and enabling this control with
the default 100 msec setting. If the CW+ Dispense manifold is not installed, better
performance may be achieved by disabling this setting. Additionally, a minor
adjustment to the duration setting may improve the performance of certain
instruments.

Service Functions

Position the wash manifold to install the shipping bracket: prior to packing up the
instrument, click the link and install the manifold shipping bracket.

AutoPrime

LHC: Tools>Instrument Utilities> AutoPrime
Keypad: Select UTIL at the main menu, then AUTPRM

Recommended for optimum performance, AutoPrime keeps the tubing wet in
between runs and can be an essential part of your daily maintenance routine.

About AutoPrime

AutoPrime automatically primes the tubing whenever the instrument is idle for a
specified time. Keeping the tubes wet prevents clogging and mitigates fluid
evaporation at the tips. AutoPrime's submerge feature lets you soak the tubes for
extended periods, which is an effective maintenance option.

Specify the Interval and AutoPrime Parameters

AutoPrime runs when the instrument has been idle for a specified interval.

To set the AutoPrime Interval:
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LHC:

. Select

Tools>Instrument
Utilities> AutoPrime

tab.
Specify the idle-time
interval that will trigger

an AutoPrime; up to 24
hours.

Enable and define the
parameters. Remember to
set a Submerge Duration
to employ this option.

Click Send to transfer the

settings to the instrument.

| Keypad:
ill,

Select UTILS at the main menu
and select AUTPRM.

Specify the idle-time interval
that will trigger an AutoPrime;
up to 24 hours in minutes and
press Enter.

Set the Submerge Duration, if
desired.

"Enable AutoPrime."

5. Define the AutoPrime

parameters: rate, volume, and
buffer valve, if applicable. Press
Enter at each screen to advance
to the next.

AutoPrime| 75
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Maintenance

Regular maintenance is required to achieve optimal
performance with the 405 LS. This section provides guidelines
and instructions for basic daily maintenance and the
Recommended Maintenance Schedule. Find comprehensive
instructions for performing regular maintenance in the
operator's manual.

Recommended Maintenance Schedule ... ... . ... ... i 79
Daily Maintenance ... ... ... ... i 81
Overnight/Multi-Day Maintenance ... ... 81
AutoClean the Washer ... ... i 82

Removing Protein Residuals and Fungi Growth ......_............... ... 85
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Overview
A Preventive Maintenance (PM) regimen for the 405 LS includes rinsing and
soaking the fluid path and cleaning and/or autoclaving the various components.
The level of maintenance required to keep the instrument performing as expected

is dependent on several factors, including the type of fluid dispensed, the
frequency of use, and the work habits employed.

The Recommended Maintenance Schedule on the facing page summarizes BioTek’s
recommended maintenance tasks, and indicates approximately how often each task
should be performed. Daily and periodic routines and minimal guidelines for
frequency are listed. Beyond that, it is difficult for BioTek to recommend a fixed
frequency for each task to be performed. The frequency of conducting these tasks
must be based on the risk and performance factors of your assays.

Develop a maintenance schedule for your 405 LS based on the characteristics of the
fluids used and the activity level. Here are some guidelines:

Washer

« When using fluids prone to dry and harden quickly, the washer’s dispense
and aspirate tubes can clog quickly, and must be rinsed frequently and
cleaned regularly. Run AutoClean ultrasonic cleaning regularly, when
available.

. If the washer will be idle for several hours or days at a time, soak the
tubes to keep them in a "wetted” state. Enable AutoPrime if the washer
is idle for more than 3 hours.

« Wash solutions affect the rinse frequency. If the solution does not
contain surfactant, consider rinsing (or running AutoPrime) at least
once an hour.
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i!ecommended Maintenance Schedule

Keypad Users: The protocol names onboard the washer do not include the W- prefix and
some protocols include the model name, e.g. 405HT or 405Select, when appropriate.

Frequency
Tasks Daily  Overnight/ | Weekly | Periodic/ | Before
Multi-Day Monthly | storage/
shipment
Washer
Run W-DAY_RINSE v v
Run AutoPrime v
Run W-OVERNIGHT_LOOP v
(LHC Only)
Run W-RINSE_AND_SOAK v
Run Verify™ clog detection |
test
Run AutoClean v 4
Components
Remove protein residuals and v v v
fungi growth, (if necessary) !
Check/empty waste bottles v | v
Direct Drain bottles: Clean
direct-drain waste bottle filter
Clean bottles v v
Clean plate carrier system l v v
Clean washer manifold | v 4
Clean aspirate and dispense v v
tubes
Clean exterior surfaces and v
mist shield
Clean buffer bottle fluid filter v v
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Frequency
Tasks Daily | Overnight/ | Weekly | Periodic/ | Before
Multi-Day Monthly | storage/
shipment
Clean vacuum filtration v v
system
Clean the Verify™ level sensor v v
Decontaminate
Decontaminate external v v
surfaces
Run W-DECONTAMINATE e .
Decontaminate vacuum v
filtration system
Prepare for Storage or Shipment
Run W-LONG_SHUTDOWN v
Replace/Repair Components
Replace the Verify Test Plate As Needed
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Daily Maintenance

Daily maintenance involves flushing the washer and dispensers with an appropriate
reagent or deionized water throughout the day. Routine rinsing helps to prevent the
aspirate and dispense tubes from clogging between runs. Flushing the devices with
deionized water is recommended at the end of the day for most applications.

The recommended rinsing frequency depends on the solutions currently in use:

. When a solution containing surfactant is used throughout the day, perform the
rinsing procedure when the device is idle for more than 3 hours.

. When the solution does not contain surfactant, consider rinsing at least once an
hour.

Run thisthese protocols and enable AutoPrime to satisfy the daily maintenance
requirements:

« DAY_RINSE

Make sure the supply bottles contain sufficient rinse solution and that the waste
bottles are empty before running the protocols.

Also see the additional maintenance procedures required when dispensing protein
solutions: Removing Protein Residuals and Fungi Growth on page 85.

AutoPrime
AutoPrime automatically conditions the dispense tubes, priming them with the
specified volume, after a user-specified amount of idle time.
. Press the STOP button to interrupt the AutoPrime routine when it is underway.

. Any interaction with the instrument via the keypad or the LHC resets the
interval clock.

« AutoPrime only runs when the main menu, quick menu, or run completion
message is displayed on the keypad.

Overnight/Multi-Day Maintenance

Overnight/ multi-day maintenance involves flushing all solutions out of the
instrument, and then periodically rinsing and soaking the tubes to keep them moist.
Here are three recommendations for accomplishing the task. Employ the method that
best suits your work flow:
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——Overnight Loop
To keep the wash manifolds in a wetted condition, you can run these predefined
protocols to soak the tubes for several hours at a time:
« OVERNIGHT_LOOP: requires the washer to remain turned on.

« RINSE_AND_SOAK: alternatively, run this protocol and turn off the
instrument after the soak begins. The tubes will soak in the priming trough
until the instrument is turned on again.

AutoClean the Washer

[W_'ﬁ“‘mmﬂ] Learn About AutoClean below

Some models of the 405 LS feature BioTek's Ultrasonic Advantage™ for easy and
thorough cleaning of the wash manifold. Instruments with AutoClean capability are
easily identified by the stainless steel priming reservoir built into the instrument's
base, under the wash manifold.

[
— Warning! Ultrasonic energy is present in the cleaning reservoir when
the AutoClean program is running. Do not put your fingers in the bath!
Ultrasonic energy can harm human tissue.

« Important! Ensure there is adequate room in the waste bottle and
sufficient volume in the supply bottle before running AutoClean!

Tip: Detergent such as Terg-A-Zyme® added to deionized water in the supply bottle
helps to break down the water’s surface tension and enhances the cleaning process. Terg-
A-Zyme also contains protease enzyme for assimilating protinaceous residue such as
bovine serum albumin (BSA).

About AutoClean

BioTek's Ultrasonic Advantage™ is a built-in ultrasonic cleaner that provides
enhanced maintenance capabilities by using ultrasonic pulses in a water bath to
clean the manifold tubes. Ultrasonic energy causes cavitation forces within the
water bath, which in turn cause tiny vapor bubbles to be created. The formation
and subsequent collapse of these bubbles is the mechanism that cleans the
manifold tubes submerged in the bath.
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The cleaner consists of a stainless steel reservoir with an ultrasonic transducer
bonded to the bottom of the reservoir. The reservoir is mounted under the washer
manifold and also functions as the priming trough.

« Do not try to remove the ultrasonic cleaner! Only BioTek authorized
service personnel should remove the ultrasonic cleaner for maintenance
or repair.

While the program is running, the ultrasonic cleaner will pulse on and off
approximately every ten seconds, and you will hear a periodic hissing sound that
indicates the ultrasonic energy is present.

« Not all 405 LS models are equipped with this feature.

Quick Clean (Keypad Only)

Select Quick>Sonic

Take advantage of the 405 LS's "Ultrasonic Advantage" to make sure the manifold
tubes are clean and clog-free.

1. Connect a bottle with detergent or an appropriate solution for your assay. The 405
LS primes the system with 300 mL/305 mL for CW models and fills the trough
with 93 mL for the sonicator. Buffer Switching models: specify the CLNBUF (Clean
Buffer) valve it is connected to; non-Buffer Switching models will be prompted to
change buffer bottles.

2. Fill the "Rinse Buffer" bottle with at least 305 mL of deionized or distilled water or
with a wash bulffer to leave the instrument primed and ready for use. Buffer
Switching models: specify the RINBUF (Rinse Buffer) valve.

3. Set the desired duration in minutes, up to 4 hours, to soak the tubes and run the
sonicator: use the arrow or Options key.

4, When you're ready, press Start.

|
——\ Warning! Ultrasonic energy is present in the cleaning reservoir when
the AutoClean program is running. Do not put your fingers in the bath! Ultrasonic
energy can harm human tissue.

. Important! Ensure there is adequate room in the waste bottle and
sufficient volume in the supply bottle before running AutoClean!
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Create an AutoClean protocol - — —

Create an AutoClean protocol for regular use. Make sure it begins by priming the
tubing with the cleaning fluid. Approximately 93 mL of fluid fills the reservoir
during each run.

General Recommendation: Run AutoClean for 1 hour. Follow with a full prime
using deionized water to remove the detergent from the system and/or with a
wash buffer to leave the instrument primed and ready for use.

LHC ’ Keypad

| W-hwtaClean | ’ DEFINE>CREATE>NAME>PLATE>ADD>WASHER—™ >ACLEAN

Define the cleaning protocol:

1. First, add a Prime step to fully prime the Protocol Steps

tubing with the cleaning fluid (or water). Jul W-Prime 500 mL
[](r;-: W-AutoClean far 01 hrs, 00 min

2. Add an AutoClean step to the protocol. <end of steps>

3. Buffer Valve: select the supply bottle containing the desired cleaning
fluid if Buffer Switching is installed.

4. Duration: enter the duration, up to 4 hours. Input the time in minutes
when using the keypad; hours and minutes when using LHC.

5. Click OK to add a cleaning step to the protocol.

Submerge and Shutdown

An overnight/ multi-day maintenance option for soaking the tips and turning off
the instrument for overnight and weekend maintenance.

You can soak the 405 LS dispense manifolds by filling the priming troughs and
turning off the instrument after the soak begins. The tubes will soak in the priming
troughs until the instrument is turned on again.

1. Run RINSE_AND_SOAK.

2. When the wash manifold is submerged, turn off the instrument.

Run a System Self-Test to empty the washer's priming trough when restarting the
instrument.
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Removing Protein Residuals and Fungi Growth

|
— Important! Solutions containing proteins, such as bovine serum albumin
(BSA), will compromise the 405 LS’s performance over time unless a strict
maintenance regime is adhered to. Do not use isopropyl alcohol or DI water to
flush out BSA or similar fluids.

When using protein solutions or similar fluids, BioTek recommends performing the
following additional Maintenance procedures to thoroughly flush out protein
particles and other contaminants from the fluid path.

Daily Practice with buffer and deionized water:

If the 405 LS will be idle between plates for longer than 45 minutes, flush the proteins
using buffer. Use buffer for the AutoPrime, as well, for immediate reuse of the
instrument. Otherwise, if the tubes will be allowed to dry, flush the system with

DI water to remove the buffer:

1. Fill a supply bottle with buffer solution. Connect the bottle to the washer. (Buffer
valve “A” for Buffer Switching models.)

2. Run the DAY_RINSE protocol.

3. Enable AutoPrime for 60-minute intervals.

« Flush the buffer from the system using DI water when the device will be
idle for an extended period, i.e. repeat steps 1 and 2 using water.

At the end of the day:

1. Fill a supply bottle with buffer. Connect the bottle to the washer. (Buffer valve
“A” for Buffer Switching models.)

2. Run the DAY_RINSE protocol three times.
3. Fill a supply bottle with deionized water. And repeat steps 1 and 2.

4, Perform your regular Overnight/Multi-Day Maintenance routine.

Weekly or As Needed use NaOH and HCI to remove proteins:

1. Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by
neutralization with an equivalent normality (0.1-0.5 N) of HCI (hydrochloride).

2. Rinse well with deionized water to remove the HCI.

3. Run the DAY_RINSE protocol three times with deionized water if you plan to
use the device immediately.
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« * N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW)
of solute per liter of solution. The gram equivalent weight is equal to the
molecular weight expressed as grams divided by the ‘valency’ of the
solute.

Alternatively use an Enzyme-Active Detergent:

1. Mix an enzyme-active detergent according to the manufacturer’s directions to
fill a four-liter supply bottle. Connect the bottle to the washer’s Buffer valve A.
Connect a bottle of deionized or distilled water to Buffer valve B to rinse the

tubing.
2. Run the DECONTAMINATE protocol, as appropriate.

3. LHC users: Respond to the Delay message, “Connect a bottle of water...”,
leave the detergent bottle connected and when ready, press Continue.

4. When the protocol is completed, connect a bottle containing four liters of
deionized water and run DAY_RINSE three times to flush the system.

Clean the Buffer Bottle Filter

Periodically clean the buffer bottle filter and direct-drain waste bottle filter (PN
01310):

» Perform this task when the buffer bottle is empty or over a sink to catch
spillage.

- Direct Drain Waste Bottle Filter: Handle with care! When cleaning the
waste bottle filter, be aware of any potential biohazard and handle
appropriately.
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4. Rinse the filter and

. Open the buffer bottle
and lift the cap and its
tubing up and out of
the bottle.

. Remove the fluid filter
at the bottom of the
tubing.

. Wash the filter with
hot water and a soft-
bristled brush, if
necessary.

reinstall it.
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Safeguards and
Troubleshooting

This section lists warnings and precautions that must be taken
when operating the 405 LS. It also includes guidelines for error
recovery and troubleshooting performance problems.
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Hazards and Precautions

Hazards

The following hazards are provided to help avoid injury:

A

Warning! Power Rating. The instrument’s power supply or power cord
must be connected to a power receptacle that provides voltage and
current within the specified rating for the system. Use of an
incompatible power receptacle may produce electrical shock and fire
hazards.

Warning! Electrical Grounding. Never use a plug adapter to connect
primary power to the external power supply. Use of an-adapter
disconnects the utility ground, creating a severe shock hazard. Always
connect the power cord directly to an appropriate receptacle with a
functional ground.

Warning! Service. Only qualified technical personnel should perform
service procedures on internal components.

Warning! Accessories. Only accessories which meet the manufacturer’s
specifications shall be used with the instrument.

Warning! Lubricants. Do not apply lubricants to the microplate carrier or
carrier track. Lubricant on the carrier mechanism will attract dust and
other particles, which may obstruct the carrier path and cause the
instrument to produce an error.

Warning! Liquids. Avoid spilling liquids on the instrument; fluid
seepage into internal components creates a potential for shock hazard
or instrument damage. If a spill occurs while a program is running, abort
the program and turn the instrument off. Wipe up all spills immediately.
Do not operate the instrument if internal components have been
exposed to fluid.

Warning! Unspecified Use. Failure to operate this equipment
according to the guidelines and safeguards specified in this manual
could result in a hazardous condition.

Warning! Direct Drain Waste. If installed, the direct drain waste
system pumps waste fluids from the washer directly into a sink or tank,
and, potentially into public waste water systems. Because the waste
may be a biohazard, you must ensure that you are in compliance with
your local or national government’s laws regarding safe disposal of the
waste.
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Warning! Ultrasonic Energy. Ultrasonic energy is present in the
ultrasonic cleaner reservoir (if equipped) when AUTOCLEAN/Quick Clean
programs are running. Avoid putting your fingers in the bath. Ultrasonic
energy can be destructive to human tissue.

Warning! Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software
parameters and establishing washing or dispensing methods. Failure to
conduct quality control checks could result in erroneous test
data.

Warning! Internal Voltage. Always turn off the power switch and
unplug the power supply before cleaning the outer surface of the
instrument.

Warning! Potential Biohazards. Some assays or specimens may
pose a biohazard. Adequate safety precautions should be taken as
outlined in the assay’s package insert. This hazard is noted by the
symbol shown here. Always wear safety glasses and appropriate
protective equipment, such as chemically resistant rubber gloves and
apron.

Warning! Pinch Hazard. Some areas of the instrument or its
components can present pinch hazards when the instrument is
operating. Depending on the instrument or component, these areas are
marked with the symbol shown here. Keep hands/fingers clear of these
areas when the instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument:

A

Caution: Service. The instrument should be serviced by BioTek
authorized service personnel. Only qualified technical personnel should
perform troubleshooting and service procedures on internal components.

Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may
result in a loss of warranty and potentially impair instrument performance
or cause damage to the instrument.

Caution: Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, ambient temperatures
should remain within the range listed in the Specifications section.
Performance may be adversely affected if temperatures fluctuate above
or below this range. Storage temperature limits are broader.
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Caution: Sodium Hypochlorite. Do not expose any part of the
instrument to the recommended diluted sodium hypochlorite solution
(bleach) for more than 20 minutes. Prolonged contact may damage the
instrument surfaces. Be certain to rinse and thoroughly wipe all surfaces.

Caution: Buffer Solution. Although many precautions have been taken
to ensure that the instrument is as corrosion-proof as possible, the
instrument is not sealed and liquids can seep into sensitive components.
Make sure that any spilled buffer solution is wiped off the instrument.
Prolonged exposure to salt solution may corrode parts of the microplate
carrier, movement rail, springs, and other hardware.

Caution: Chemical Compatibility. Some chemicals may cause
irreparable damage to the instrument. The following chemicals have been
deemed safe for use in the instrument: buffer solutions (such as PBS),
saline, surfactants, deionized water, 70% ethyl, isopropy!, or methyl
alcohol, 40% formaldehyde, and 20% sodium hydroxide. Never use acetic
acid, DMSO, or other organic solvents. These chemicals may cause
severe damage to the instrument. Contact BioTek for more information
and prior to using other questionable chemicals.

Caution: Bovine Serum Albumin. Solutions containing proteins, such
as bovine serum albumin (BSA), will compromise the instrument’s
performance over time unless a strict maintenance protocol is adhered to.
See Maintenance procedures regarding BSA.

Caution: Power Supply. Only use the power supply shipped with the
instrument. Operate this power supply within the range of line voltages
listed on it.

Caution: Disposal. Dispose of the instrument according to Directive
2002/96/EC, “on waste electrical and electronic equipment (WEEE),"” or
local ordinances.

Caution: Warranty. Failure to follow preventive maintenance protocols
may void the warranty.

Caution: Shipping Hardware. All shipping hardware (e.g., shipping
bracket etc.) must be removed before operating the instrument and
reinstalled before repackaging the instrument for shipment.

Caution: High Flow Pump Installation. DO NOT plug the High Flow
vacuum pump cable into a wall outlet! Use the adapter provided with the
pump to connect the pump to the accessory outlet on the back of the
washer. See the Installation instructions.
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Caution: Waste Sensor Port on 405 LS. (For customers who have
purchased the BioStack Microplate Stacker.) Although the waste sensor
port on the back of the 405 LS is the same type as the 24-VDC power
connector on the back of the BioStack, if an external 24-VDC power
supply is plugged into the 405 LS’s port, it will permanently damage
internal components.

Caution: Do not run the Peri-pump without a cassette installed on the
pump.

Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the
user’s responsibility to ensure that a compatible electromagnetic
environment for this instrument is provided and maintained in order that
the device will perform as intended.

Caution: Electromagnetic Compatibility. Do not use this device in
close proximity to sources of strong electromagnetic radiation (e.qg.,
unshielded intentional RF sources), because these may interfere with the
proper operation.

CE Mark

q3

Based on the testing described below and information
contained herein, this instrument bears the CE mark.

« Note: See the Declaration of Conformity for specific information.

Directive 2014/30/EU: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing laboratory
and found to meet the requirements of EN 61326-1: Class A for Radiated Emissions
and Line Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011
(CISPR 11) Class A. In a domestic environment it may cause radio interference, in
which case, you may need to mitigate the interference.

Immunity

The system has been type-tested by anindependent, accredited testing laboratory
and found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity.
Verification of compliance was conducted to the limits and methods of the following:

EN 610004-2, Electrostatic Discharge

BioTek Instruments, Inc.
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EN 610004-3, Radiated EM Fields
EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2014/35/EU Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was
found to meet the requirements of this Directive. Verification of compliance was
conducted to the limits and methods of the following:

EN 61010-1, “Safety requirement for electrical equipment for measurement,
control and laboratory use. Part 1, General requirements.”

EN 61010-2-081, “Particular requirements for automatic and semi-automatic
laboratory equipment for analysis and other purposes.”

Directive 2012/19/EU: Waste Electrical and Electronic Equipment

Disposal Notice: Dispose of the instrument according to Directive 2002/96/EC,
“on waste electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

« Product registration with competent authorities.
. Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN 61010-2-101 Particular requirements for in vitro diagnostic (IVD) medical
equipment.

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment

405™ Microplate Washer LS
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generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause harmful interference

to radio communications. Operation of this equipment in a residential area is

likely to cause harmful interference, in which case the user will be required to

correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be
used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and television reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Le present appareil numerique n'émet pas de bruits radioelectriques depassant
les limites applicables aux appareils numerique de la Class A prescrites dans le
Reglement sur le brouillage radioelectrique edicte par le ministere des
Communications du Canada.

Intended Use Statement

« The 405™ Microplate Washer LS provides microplate priming, washing, and
dispensing for ELISA™, fluorescence and chemiluminescence immunoassays,
cellular and agglutination assays.

« If the instrument has an "IVD" label it may be used for clinical and non-clinical
purposes, including research and development. If there is no such label the
instrument may only be used for research and development and non-clinical
purposes.

User Safety

This device has been type-tested by an independent laboratory and found to meet the
requirements of the following:
. Underwriters Laboratories UL 61010-1 “Safety requirements for electrical

equipment for measurement, control and laboratory use; Part 1: general
requirements.”

. Canadian Standards Association CAN/CSA C22.2 No. 61010-1 "Safety
requirements for electrical equipment for measurement, control and laboratory

BioTek Instruments, Inc.
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use; Part 1: general requirements.”
« EN 61010 Standards, see CE Mark on page 93.

Quality Control

It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for
the test to be conducted. Failure to conduct Quality Control checks could result in
erroneous test data.

Warranty and Product Registration

Please take a moment to review the Warranty information that shipped with your
product. Please also register your product with BioTek to ensure that you receive
important information and updates about the product(s) you have purchased.

You can register online through BioTek’s Customer Resource Center (CRC) at
www.biotek.com or by calling 888/451-5171 or 802/655-4740.

405™ Microplate Washer LS
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Safety Symbols

Some of these symbols appear on the instrument or accessories:

Y

Alternating current
Courant alternatif
Wechselstrom
Corrientealterna
Correntealternata

Direct current
Courant continu
Gleichstrom
Corriente continua
Corrente continua

On (Supply)

Marche (alimentation)

Ein (VerbindungmitdemNetz)
| Conectado

| Chiuso

Off (Supply)
Arrét (alimentation)
Aus (TrennungvomNetz)
Desconectado
Aperto
(sconnessionedallaretedialimentazione)

Warning, risk of electric shock
Attention, risque de choc électrique
Gefahrlicheelektrischeschlag
Precaucidn, riesgo de sacudidaeléctrica
Attenzione, rischiodiscossaelettrica

Warning, hot surface
Attention, surface chaude
Warnen, heiBeOberfléche
| Precaucion, superficiecaliente
| Attenzione, superficiecalda

%

1

D
A
J

Both direct and alternating current
Courant continu et courant alternatif
| Gleich - und Wechselstrom
Corriente continuay
corrientealterna
Corrente continua e
correntealternata

Earth ground terminal
Borne de terre

Erde (Betriebserde)
Borne de tierra

Terra (difunzionamento)

Protective conductor terminal

Borne de terre de protection

Schutzleiteranschluss

Borne de tierra de proteccién
Terra diprotezione

Caution (refer to accompanying
documents)

Attention (voir documents
d’accompanement)
AchtungsieheBegleitpapiere
Atencion (vease los
documentosincluidos)
Attenzione, consultare la doc
annessa

Attention, risqued’écrasement et
pincement

Warnen, Gefahr des Zerquetschens
und Klemmen

Precaucion, riesgo del
machacamiento y sejecion
Attenzione,
rischiodischiacciareedintrappolarsi

Warning, potential biohazards
Attention,
risquesbiologiquespotentiels
Warnung!
MoeglichebiologischeGiftstoffe
Atencién, riesgosbiolégicos
Attenzione, rischiobiologico

BioTek Instruments, Inc.
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IVD

In vitro diagnostic medical device
Dispositif médical de diagnostic in vitro
Medizinisches In-Vitro-Diagnostikum
Dispositivo médico de diagnostico in
vitro

Dispositivo medico diagnostico in vitro

Consult instructions for use
Consulter la notice d’emploi
Gebrauchsanweisung beachten
Consultar las instrucciones de uso
Consultare le istruzioni per uso

| Separate collection for electrical and

electronic equipment
Les équipements électriques et
électroniques font I'objet d'une
collecte sélective

Getrennte Sammlung von Elektro-
und Elektronikgeraten

Recogida selectiva de aparatos
eléctricos y electrénicos

Raccolta separata delle
apparecchiature elettriche ed
elettroniche
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Troubleshooting

Error recovery:

First Response: Run a System Test (restart the instrument) to give the instrument an
opportunity to restore its initial settings and communication capability.

LHC Users: Reboot your Computer and Instrument: When you cannot run a system
test, e.g. LHC is not responding, or when running a system test doesn't resolve the
issue, turn off your computer and 405 LS, check all the cabling, i.e. make sure your
serial or USB cable is in good condition and is properly connected to the PC and
instrument, and then, power them on. This should refresh the devices and reset
communication parameters.

Error Codes
To find a specific error code:
. Software Error Codes (6000-6200) - protocol errors

« System Error Codes (0000-A500) - hardware errors
Most error conditions generate an error message that is displayed on the computer

screen or keypad.

The most common error for new 405 LS users is easily fixed:

( 306 | Peri-pump Pump Cover is open. Close the pump cover and re-run protocol. I

To run the Peri-pump, its pump cover must be closed, protecting both the pump and
the operator.

| 401 | Carrier Y motor failed positional verify |

If the plate carrier is not installed correctly, this instrument error will be displayed.
Make sure the back right corner of the carrier is correctly seated in the little black
knob attached to the transport rail. A slit on the bottom of the carrier allows it to fit
into place.

[ 6045 | Serial write error |

LHC Users: A potentially common error, especially when using the Predefined
Protocols, a "serial write" error, is easily fixed by correcting the COM port setting
defined in the protocol.

| 810D \ To communicate, instrument must be at main menu/Home screen. \

LHC Users: Similarly, the 810D message appears when the instrument is busy, for
example when AutoPrime is running. The LHC can only talk to the instrument when

BioTek Instruments, Inc.
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its main menu is displayed. Press the Stop button; if desired, to-end the carrent——
process and reestablish communication with the LHC.

o Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You
can use USB to connect the 405 LS to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your 405 LS, you are
controlling both instruments using the keypad. Before connecting the 405 LS to
your computer to download basecode or for other reasons, you must first
disconnect the BioStack from the 405 LS and change the Instrument Setting for the

BioStack: Press Setup Menu> —>> BIOSTK> CONF>MANUAL.

Washer Troubleshooting

Review these suggestions to correct problems your washer is having:
« Vacuum Pump Problems on page 108
« Fluid Aspiration on page 102
« Fluid Delivery on page 104
« Fluid Leakage on page 106
« Washer Manifold Movement on page 107
« Verify Technology Level Sensor Troubleshooting on page 108

405™ Microplate Washer LS
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Microplate Carrier Movement

Problem AL ‘ What To Do

Cause ‘
Aspiration Microplate not | Reseat microplate in carrier or strips in holder.
tubes not properly Make sure the carrier is clean.
entering seated or Try a different microplate or strip holder. If the
wells strips not | problem is unresolved, the carrier may have to be
correctly. level. | realigned. Contact BioTek TAC.

Aspirate tubes | Change the horizontal, X- or Y-axis aspirate position

position is too | in the protocol.

wide for a

-‘movement.

Aspirate tubes | Contact BioTek TAC.

bent.
Loud, Plate carrieris | Thoroughly clean the microplate carrier and exterior
annoying rubbing surface as recommended in the maintenance
noise during | against glide procedure.
operation. | strip.
384-well Microplate Clean the plate carrier system. If problems persist,
plates not | carrier not contact TAC for assistance cleaning the carrier
properly moving transport arm.
washed. correctly in the

Y-axis. |
Uneven Plate carrier Replace plate carrier: contact BioTek TAC for
performance. | leveling feet | assistance. Note: "Q" model washers with Verify™

damaged. Technology must recalibrate the Verify test plate

| after installing the new carrier.

BioTek Instruments, Inc.
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———Fluid-Aspiration ——

Problem Possible Cause What To Do

Poor or Insufficient or no Firmly seat the waste bottle covers. Ensure
uneven vacuum. tubing is connected properly.

aspiration. .

Check all external tubing and in-line filter for
kinks or clogs. If you are using an in-line
vacuum filter, it may need to be replaced.

With the vacuum pump on, remove the
vacuum pump tubing from the back of the
instrument. Put your finger over the port; if
there is no vacuum, contact BioTek TAC.

Clogged aspiration
tubes on the
washer manifold.

Remove and clean the washer manifold

Make sure the microplate carrier is level and
the waste valve is not touching the bench.

Aspirate height
adjustment too
high or too low.

Change the aspiration height (Z-axis
position) in the protocol. Similarly, make sure
the Magnet Adapter Height offset is disabled

| or not too high.

Vacuum pump
failure.

Contact BioTek TAC.

405™ Microplate Washer LS




Troubleshooting| 103

Problem Possible Cause What To Do
Uneven No surfactant in Add surfactant to the buffer. If this is not
aspiration of | the buffer, such as | possible, continue below.
water buffer. | Tween® 20.
Some wells | o . . - -
left full. Insufficient BioTek offers a high-flow pump for assays
vacuum. using only water for the wash fluid. Contact
BioTek for more information.
Protocol settings Optimize protocols to improve evacuation
not optimized.
Aspiration tubes If none of the tubes are bent, try adjusting
not properly the horizontal aspirate position (X-/Y-axis) in
positioned the protocol.
horizontally in
wells.
Microplate not level | Reseat microplate in carrier or strips in
in carrier, or strips | holder.
not level in holder. | Make sure the carrier is clean.
Try a different microplate or strip holder.
| If the problem is unresolved, the carrier may
' have to be realigned. Contact BioTek TAC.
Too much Clogged vacuum If you are using an in-line vacuum filter (PN
residual left in | filter. 49943), the filter may need to be cleaned or
wells after replaced.
aspiration. > SN T

Waste bottle cover
not properly sealed
or fittings not
properly
connected.

Firmly seat the waste bottle stopper. Make
sure tubing is connected properly.

| Manifold out of
alignment or not
moving freely.

Protocol requires
optimization.

Aspirate tubes are
bent.

Contact BioTek TAC.

Check for obstructions. If none are found,
contact BioTek TAC.

Optimize protocols to improve evacuation.

BioTek Instruments, Inc,
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Fluid Delivery —— -

dispense fluid — | Large air pockets in
models with the | tubing.

Problem Possible Cause What To Do

Unable to Inlet tube not Make sure all tubing is connected
dispense fluid — | connected. properly. Check all external tubing for
models without kinks or clogs.

the Buffer

Switching

module.

Clogged fluid inlet Clean the fluid inlet filter inside the

filter. supply bottle.

Clogged valve Create a protocol with several small
primes, e.g. 10 mL, to try to unclog
valve.

Clogged dispense Remove and clean the washer manifold

tubes on the washer

manifold.

No wash or rinse fluid. | Fill bottles with appropriate fluid. Ensure
bottles are clean and do not contain
particles or organic material.

Unable to System not primed. Run W-DAY_RINSE multiple times.

dispense fluid — | Large air pockets in

models without | tubing.

the Buffer

Switching |

module. |

| Insufficient suction, Perform Washer Maintenance; If the

clogged tubing, or problem persists, contact BioTek TAC.
faulty valve.

Unable to | System not primed. Run W-DAY_RINSE multiple times.

Buffer Switching | |
e, External valve

module not
connected to washer,
or supply tubing set
up incorrectly.

Solenoid valve not

Check valve module cable and tubing.

: Ensure module cable is plugged into the

405™ Microplate Washer LS
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ProI;Iem Possible Cause ‘What To Do
opening. Valve Control port on the instrument'’s
back panel. If plugged in, contact BioTek
TAC.
Plate overfills Dispense height too Lower the dispense height (Z-axis
(floods). high. The aspirate position) in the protocol.

tubes are too far
above the wells to
prevent overfiow.

Dispense flow rate Define a higher dispense Flow Rate in
too low. the protocol.

Cell wash flow rate 1 | Specify a non-CW dispense Flow Rate
or 2 is used with 384- | when using 384-well plates.
well plates.

Aspiration tubes hit Manifold may not be properly seated or
bottom of trough mounted. Contact BioTek TAC.

during Prime or
Maintenance.

In-line vacuum filter | Replace or remove the in-line vacuum
plugged. filter.

Loose covers on Firmly tighten waste bottle covers.
waste bottles. |

Dispense rate too fast - Specify slower dispense Flow Rate or
for volume selected. | lower volume.

Faulty vacuum pump. | Contact BioTek TAC.

|
Insufficient or no Firmly seat the waste bottle covers.
vacuum. Check all external tubing for kinks or
clogs.

When the program begins, you should be
able to hear the vacuum pump turn on. If
it is not turning on, contact BioTek TAC.
If the vacuum pump turns on, remove
the vacuum tubing from the back of the
instrument and put your finger over the
port. If there is no vacuum, contact
BioTek TAC.

BioTek Instruments, Inc.
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Problem

Possible Cause

Uneven
dispensing of
fluid; wells not
filled.

Clogged dispense
tubes on the washer
manifold.

Remove and clean the washer manifold

Manifold or tubing not
adequately primed.

Run W-DAY_RINSE once or twice.

Dispense flow rate
too low. Flow rate 1 or
2 CW is used with
384-well plates.

Define a higher dispense Flow Rate.

Microplate aspiration
height adjustment
too high or too low.

Change the aspirate height (Z-axis
position) in the protocol.

Dripping
dispense tubes

Dispense tubing
routed incorrectly.

Connect the fluid supply bottle tube to
the bottom port of the syringe pump.
Contact BioTek TAC if the problem
persists.

Fluid Leakage

Problem

Possible Cause

What To Do

Fluid leaking from
manifold.

Defective seals.

Aspiration tubes
only: vacuum too
low.

Replace Washer Manifold O-rings and
Seals Contact BioTek TAC

Check waste connector tubes; make sure

they are properly connected.
If you are using an in-line vacuum filter,
check the filter for clogging, and replace
if necessary.

Check seal of waste bottle covers.
Check for air leaks in the waste tubing
and bottles.

Use a slower Aspiration Travel Rate.

Uneven (not
level) surface.

Make sure the washer sits on a perfectly
level surface.
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Problem

" Po;sit;le éause

" What To Do

Fluid leaking from
underneath the
instrument.

Defective tubing
connector or inlet
tubing.

Leaking valve.

Contact BioTek TAC.

Contact BioTek TAC.

Fluid leaking from
external tubing
connector.

Defective
connector.

Worn tubing.

Worn seal (inlet
or vacuum
fitting).

Replace connector.

Replace tubing or cut back tubing one
inch (to remove worn section).

Replace filter or seal.

Washer Manifold Movement

Problem Hossibis What To Do
Cause
Manifold Manifold Check orientation of microplate; Al should be in the left
position movement is | rear corner of the plate carrier as you face the
error. blocked. instrument.
Check for and remove any obstructions.
Ensure the manifold is installed properly.
Incorrect Make sure the washer manifold setting matches the
manifold installed manifold (96-, 192- or 128-tube).
selected. LHC: Tools>Instrument Utilities>Washer>Manifold
Selection.
Keypad: Setup Menu>WASH—>>MANIF

BioTek Instruments, Inc.
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Vacuum Pump Problems

Problem Possible Cause | What To Do
Vacuum Vacuum pump is Flip the switch on the side of the vacuum pump
pump does not turned on. to turn it on.
not start, or =l T
cheEes TEan Vacuum pump Plug the vacuum pump accessory cable into
turned on. accessory cable the back of the instrument, Accessory Outlet.
not installed
correctly.
Too much residual | Release the vacuum by loosening the waste
vacuum force for | bottle stopper. Reconnect and start again.
pump.
Blown fuse in Plug the vacuum pump accessory cable into
accessory outlet. | the back of the instrument, Accessory Outlet,
not into a wall outlet.
Increase vacuum dissipation delay.
LHC: Tools>Instrument Utilities>Vacuum
Dissipation Delay.
Keypad: Setup Menu>->ADVANC->VACDIS
Replace fuse (PN 46055), Replace the Vacuum
Pump Fuse
Repeated Vacuum Dissipate | See above. If not enough time is allowed for
blown fuses. | Delay is set too the vacuum to dissipate, the pump will try to
low for the volume | start while it is under a vacuum. The pump
of the waste draws excessive current and blows the fuse.
bottle.
Pump has been Remove the head from the pump and inspect it
flooded. for corrosion, crystalline buildup or liquid.
Contact BioTek TAC for information on pump
rebuilding kits.

Verify Technology Level Sensor Troubleshooting

For 'Q' model washers with BioTek's Verify™ Technology, here are general
guidelines for fixing performance problems.

« Test fluid: use DI water or a non-foaming wash buffer like PBS.

« Prime the tubing: make sure the system is fully primed before running the test.
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Verify Test Plate only: use a calibrated test plate with a serial number that
matches the instrument.

Correctly seat test plate: make sure the test plate is properly oriented, with well
A1l in the back, left corner of the carrier and the "Front" label facing front.

Check level sensor: Remove, clean, and re-seat the collimator: Clean the Verify™
Level Sensor.

Recalibrate the test plate: If error codes like 6123 persist, you may need to
recalibrate the test plate: See Replacement Procedure for Verify Test Plate in
the operator's manual.

BioTek Instruments, Inc.
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~ Physical Specifications

Labware

Microplates 96-well, 384-well that comply with ANSI/SLAS microplate
standards 1-2004, 2-2004, 3-2004, and 4-2004.

Microstrips 1x8,1x12

Microwells Flat, round, "V” bottom

Hardware & Environmental

“User Interface

-2-line x 24 character LCDscreen, 26 alphanumericsoftkeys——

Power Supply

The instrument uses two internal power supplies: 24-volt 60
watt and 48-volt 60 watt. These supplies are compatible with
100-240 V~; 50-60 Hz.

Accessory
Outlet

<5.0 A, used for vacuum pump

Dimensions
(W x D x H)

14 x 17 x 10 inches (36 cm x 43 cm x 25 cm)

Weight (<)

Operating
Conditions

Relative
Humidity

32 1b (14.5 kg)/36 Ib with Buffer Switching (16.3 kg)

10° - 40°C (50° - 104°F)

The instrument should be operated in a non-condensing humid
environment having a maximum relative humidity of 80% at
temperatures up to 31°C decreasing linearly to 50% relative
humidity at 40°C.

Manifold Type

96-tube

Single or Dual manifold with 96 sets of aspirate and dispense
tubes arranged in an 8x12 array. Single manifolds can only

process 96-well microplates; dual manifolds can process 96-
and 384-well plates.

192-tube

Dual manifold with 192 sets of aspirate and dispense tubes
arranged in a 16 x 12 array can only process 384-well plates.

405™ Microplate Washer LS
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Waste bottle volume 4, 10, or 20 liters, depending on th_e accessory

Supply bottle volume Two 4L or 10L bottles (4 bottles w/ Buffer SW|tch|ng)

package, (2 bottles, one with sensor)

Performance Specifications

Washer

Average Residual Volume (Evacuation Efficiency)

96-Tube
Manifold (Single
and Dual)

adjustment is optimized for the plate prior to testing.

Average residual volume in the microwells is < 2 uL per well
after a 3-cycle wash, when 300 pL of deionized water with
0.1% Tween 20®, or buffer equivalent, is dispensed per well
into a Costar® 96-well flat-bottom plate. The aspirate height

192-Tube
Manifold

Average residual volume in the microwells is <2 uL per well
after a 3-cycle wash, when 100 pL of deionized water with
0.1% Tween 20, or buffer equivalent, is dispensed per well into
a Costar 384-well flat-bottom plate. The aspirate height
adjustment is optimized for the plate prior to testing.

Vacuum Filtration Evacuation Efficiency

Average increased weight of the plate is < 1.2 grams after
dispensing 300 L of deionized water per well into a
Millipore® MSHVN4450 96-well 0.45um plates (PN 98258)
and vacuum aspirated for 30 seconds and blotted on a
paper towel.

96-Well Filter
Plates
384-Well Filter
Plates

| Average increased weight of the plate is < 4.0 grams after
dispensing 80 LL of deionized water per well into a
Millipore® MZFCNOW 10 384-well 1.2um plates (PN 98287)
and vacuum aspirated for 10 seconds and blotted on a
paper towel.

BioTek Instruments, Inc.
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Dispense Precision

96-Tube < 3.0% CV when dispensing 300 pL per well of deionized water

Manifold with 0.1% Tween 20, with FD&C #1 blue dye at rate 6 into a
Costar 96-well flat-bottomed plate. The absorbance of the
solution is read at 630 nm and 450 nm reference.

192-Tube <4.0% CV when dispensing 80 pL per well of deionized water

Manifold with 0.1% Tween 20, with FD&C #1 blue dye at rate 7 into a

Costar 384-well flat-bottomed plate. The absorbance of the
solution is read at 630 nm and 450 nm reference.

Verify™ Clog Detection Technology

“Timing

-AVerify testshaltbecompleted-intessthan5minutes from
initiation until test results are displayed.

Performance

The Verify level sensor measurement shall have a repeatability
standard deviation of OF s e <0.14 mm (9.0 pL for 8X8

square well plate), whe.re the s S applies to a relative
volume measurement, i.e. the delta between two volumes.

405™ Microplate Washer LS




Package Contents| 115

Package Contents

. Part numbers and package contents are subject to change and vary
according to instrument model. Please contact BioTek Customer Care if

you have any questions.

Description

PN

Power cord (part numbers vary by country of use)
USB cable

Microplate carrier

Mist shield

Accessory kit

Stylus: for cleaning washer manifold aspirate tubes

Stylus: for cleaning 192-tube dispense manifold

Shipping bracket - model dependent

Hex wrench: 9/64"
Spare fuses (5)
Verify Test Plate for "Q" models only

Manifold Stop Screw Kit (Required for Vacuum Filtration,
384-Well PCR processing and magnetic bead assays.)

405™ LS Getting Started Guide (and operator's manual on
USB - PN 1171040)

Varies

75108

Varies

1172017
i 1 176_0 12
;;02108
I 7102139 _

7102138
1242018 or
1242021
1242032 and
1242019

48434
46055
_' 01588
| 1170011

1171014

. Some components are model specific, they ship only with certain

instrument models.

BioTek Instruments, Inc.
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—Waste and Dispense System Accessories

Part
Number

Description

Standard Vacuum Pump Systems:

1170530

Complete Dlspense/Waste System 115V/230V 4L Bottles, |nclud|ng

7100746

1170535

1170534

Complete Waste System 115V/230V 4| Bottles, including:

1170528

7100746 ‘ Waste: 4L bottles (2, one with sensor)

1170529 ' Dispense: 4L bottles with filters (2)

7100543

| Waste 4L bottles (2, one with sensor)

7103024 or
7103034

Complete Dlspense/Waste System 115V/230V 10L Bottles, |nclud|ng
1170534

Vacuum pump 115V/230V

l Waste 10L bottle (1), 4L bottle W|th sensor (1)

| Dispense: 10L bottles (2)

Complete Waste System 115V/230V, 10L Bottles, including:

7100582 Waste: 10L bottle (1), 4L bottle with sensor

7103024 or
7103034

Vacuum pump 115V/230V

High Flow Vacuum Pump Systems:

1170532 Complete Dispense/High Flow Waste System 115V/2t'30\/_, 4L Bottles,
including:
;100753 Waste 4L bottles (2, one with sensor)_ DL
- 1170529 Dlspense 4L bottles with filters (2) -
;.0075_3 Complete High Flow Waste System 115V/230V, 4L Bottles |nclu_d|r;
_ 7100543 Waste 4L bottles (2, one with sensor)
A 7100754 H|gh flow vacuum pump 115V/230V_
11705_33—_. Complete Dlspense/ngh Flow Waste System 115V/230V, 10L Bottles_ _
! including:
] 11_70531 Waste: 10L gtt_le (1), 4L bottle with sensor

405™ Microplate Washer LS
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Part

Number Description

1170528 D|spense 10L bottles (2)

1170531 Complete H|gh Flow Waste System 115V/230V, 10L Bottles, mcludmg

7100754 High-flow vacuum pump 115V/230V

7100582 Waste: 10L bottle (1), 4L bottle with sensor (1)

Direct Drain Vacuum Pump Systems:

1170560 Complete Dispense/Direct Drain Waste System with standard vacuum
R

1170562 Complete Dlspense/Dlrect Drain Waste System with high-flow
vacuum pump

1170561 Direct Drain Waste System Upgrade Kit (to replace standard waste
system)

1) Models with Buffer Switching receive a dispense system. Only a waste system
must be ordered separately.

2) High-flow waste system may be necessary for 384-well washing with buffers not
containing surfactant.

Optional Accessories

General Instrument Accessories

Description ‘ PN
BioTek liquid testing solutions for ‘ Wetting 7773002
instrument qualification tests | Agent

Blue Test 7773001

‘ Dye

Liquid Handllng Control”" Software ll LHC2
BloStackTM Microplate Stacker and |ntegrat|on kit Biostack
Installation-Operational-Performance Quallflcatlon 1170543
(IQ-0Q-PQ) package

BioTek Instruments, Inc.
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Magnetic Bead Assay Accessories

Accessory PN
Magnet Adapter Kit 7180011
Magnets:
384-well Flat Magnet 7103017
384-well Ring Magnet 7102215
96-well Flat Magnet o 71030£ N
96-well Ring Magr@ = 7102216
Vacuum Filtration Kit e W e W W i R
Description PN
Vacuum Filtration Kit 7180029
-- 96-well Only 1170008_
-- 96- and 384-well _ | 1170009
Verify™ Technology Accessories
Description PN
Verify Test Plate Replacement Kit 1240001
Miscellaneous Accessories
Description PN
96-tube Manifold Kit - Replacement kit for 405 Select to 1172046S
support 384-well non-surfactant buffer washing (Tube-in-
Tube).
96-Tube 7-Degree Dual Manifold Upgrade Kit - Additional 1170010
manifold for 405 HT for 96-well washing. (Tube-in-Tube)
4L Dispense Bottle w/filter 1173031
.ap_for_4L Disp;ens_e Bottle w/fil_t(_er_ 1173003
| 10L Dispense Bottle w/filter 1173000

405™ Microplate Washer LS
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Description D - | PN

Cap for 10L Dispense Bottle w/filter 1173002
Dis;:)ense—Tubing Set-1 Buffe_r_ - .7100538 ]
-Dispense Tubing Set —:Buf_fe_r; (_For Buffer Switching N 71_00537
models.)

4L Was;e Bottle - _ 7100534
.Cap for W;ste_BottI_e, 4L (Also fits—10L and Zoﬁottl—es.) N .7100531
.Waste Bo_ttle with Level Sensing, 4L o ;10_05_42 N
Ca_p_for Waste Bottlevvith Level Sensing, 4L 71_065; K
10L Waste Bottle_ and Tubing - _...%0557 B
20L Waste Bottle and Tubing 71_0_0556 s
Waste Tubing Set 7100533
.:/acuum Line Filter for Waste TI.lbing 48294 e
Vacuum Gauge/RegIJIa_tor (For use with house_vacuum.) 4030551
_Sﬁencing Muffler for Vacuum Pump (For use with PNs " 6_1113

7103024 or 7103034 pump.)

.FIuid filter for dispen_se_bottles (does not include stainless 01310 _

steel adapter 1172031)

Note: Check our website for a complete list of accessories: www.biotek.com

BioTek Instruments, Inc.
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Basic operation....................... 28
BioStack
How to configure/operate ............ 53
BioTek's Customer Resource Center... 6
BioTek's Ultrasonic Advantage.......... 82
Bottles
Cleanfilter. . ..............occcooiiiiiie. 86
Connection ............ccooooeieieiiiiin... 12

Buffer Switching
installation . .....ssssesanmz s 16
C
Cell Wash............ooco. 55-56
Strategy to preserve cells.............. 57
Change
Fluids ... 56
Cleaning........cc...... e R 82
Removing proteins....................... 85
COMPOTt ... 21, 47-48
Copy a protocol...............ooooiiii 39
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Download protocols......................... 48
Dripping manifold.......................... 106
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Verify sensor..............cccccceeeeeeenn... 50 Defining ..........cccoooiiiiiiiiiiiis 32
IQ-OQ-PQ............ ccsseccsaasass 117 supported ....................;omEEs - 112
" Port link.................ol 47-48
Power Supply......cccoveviiiiiiiiiiin 112
Keypad........o.cooeoeeeeee 31,39 Prevent fluid loss during wash.......... 58
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Low Flow .. 55 Naming ... 39
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M
Q
Magnet Height Offset........................ 65
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Maintenance ...........ooooooe e 79 I-nstrument """"""""""""""""""" 23
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Manifold Selection............................ 72 R
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Transfer protocols....... i ———— 48
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U
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\'
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LOW o 102
turnoff ... 31
Vacuum Dissipate............................ 21
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Valve module
installation.................. 16
Verify Technology............................ 50
W
Wash
Gentle, cell wash .......................... 55
Magnetic beads ...............c............ 60
Polystyrene beads........................ 68
QUICK - 32

Washer
Fixing problems.......................... 100
Protocol parameters listing............ 34
Washer Prime step ....................... 30
Washer Settings................... 72
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Installation...............ccooooinn. 12
SENSOT ... oeoeeieeiieee e cne e 73
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— 405 TS/LS Chemical Compatibility Chart

Table 1: Material/Where Used List

# ~ Material _
1 304 Stainless Steel
2 316 Stainless Steel

3  Acetal

4  Aluminum (anodized)

5 CPVC (Chlorinated Polyvinyl

____chloride)
6 Nylon
-7 PTFE (polytetrafluoroethylene)

Teflon

8 EPDM (Et_hyl_eﬁe Propylene)

S Neoprene

10 PPO (polyphenylene Oxide)
Noryl® -

11 Polycarbonate

12 Polyethylene

13  Polypropylene

14 bélysg{réne

15 PVC (Polyvinyl chloride)

16 PPS (polyp_l'\enylenesulfide)
Ryton®

17 Thermoplastic elastomer
Santoprene®

18 Silicone

19 Ultem (polyetherimide)

20 Viton

Where Used

“Inlet screen, feeder tube to manifold, vacuum

switch, direct-drain inlet screen

Dispense and aspirate tubes, feeder tube to
manifold, spring in bottle fittings
Vacuum-filtration plug

Microplate carrier, vacuum-filtration carrier grill
and retainer

Manifold, vacuum-filtration carrier
Inlet fitting, vacuum switch adJustment screw,

carrier leveling feet

Optional check valves (PN: 68098) for fluid
pump, fluid path

Inlet valve, vacuum filtration 3-way valves,
vacuum switch diaphragm - = =
Manifold channel-end seals

Vacuum switch internal disc

Vacuum switch body, Vacuum-filtration
intermediate waste bottle =
Buffer bottle B -

Outlet fitting, fittings in bottles, inline fittings,
float ball, bottle caps, vacuum-filtration module
bulkhead fittings, direct-drain module fittings

Flow sensor, mist shield, assay plates
Inlet valve, waste sensor, flow sensor ball

retainer, waste tubing, vacuum-filtration plug,

direct-drain bottle sensor _
Fluid pump, vacuum-fiitration plug, inlet valve

(serial # less than 207137), direct-drain fluid
pump

Fluid pump check valves, direct-drain pump

check valves -
Inlet tubing, outlet tubing, o-rings, vacuum-
filtration carrier gasket, vacuum-filtration

‘module tubina. direct-drain._module tubing

Outlet valve, CW inlet valve, vacuum-filtration
module valves, direct-drain module valves

Outlet valve, CW inlet valve, direct-drain valves

BioTek Instruments, Inc.



Appendix C: Chemical Compatibility

Table 2: Chemical Compatibility Ratings

Key 1121345678910 11]12|13]| 14 |15]|16| 17| 18 | 19 | 20
A - Excellent —| — o
c — - . W ]
B - Good o 9 E o ol 5|6 2 § S| £ )
ol e 3 = - [a% W L
- Fair 7802 g 8| R B g2l 525 5 ¢z 5 g 2 &
8] ~l v n| =| ES ~
D - Severe effect/Poor 39| < g of = E L2 éo) ol =2 2 z z 14 E al 2| ©
ND - No data @l ™ o al a|&| | = I
Chemical 112134567 [8]9]10]11]12]13] 14 [15f16]17( 18 | 19 | 20
Acetic Acid, 5% D |[aAlD|lB|A|D|A|ND[B|A|A|A|A| D |D|A]|C C A B
Acetic Anhydride B |A[D|lA|D|[A|A|A|[B|D|DI|C|B| D D|A| A A |[ND| D
Acetonitrile ND|A|ND|B|D|A|A|C|ND|IND| D |A|A| D D|A[ND| D D D
Ammonia 10% A |A|lD|A|A|A|A|IND|A|A|D|N|JA| B B|A| A D D D
Benzyl Alcohol B |[e|lAa|BlAlB|lA|B|C|DIND|A|A| D |DJA| A A |ND| A
Chloroform A la|lAlB|[D|A|A|D|D|D|DI|D[C]| D D|A[D D D A
Detergents 1% A |lalalBlalalalalAalalAalAalA]l A |AIAIB A A A
Dimethylformamide A |B|/D|IA|D|A|A|B|D|D|DJC|A| D D|A| D A |[ND| C
DMSO (Dimethylsulfoxide) —|{ND| A~ |ND|-A | D-| A |[-A-|[ B |ND{ND{ B | A|-A-| D D-| A{-D o 5= F=p)
Ethyl Alcohol 70% A |lA|lA|lA|B|A|A[AlA|A|BIBIAI A B|A| B B A B
Ethylene Oxide B |eiplb|lclID|lA|C|D|A|JC|A|D]| C C|D|ND| A IND| C
Formaldehyde 37% A |lAalalBlAalAalAalAa]lB|A[A|DIAIND|AJAIND| C A A
Hexane A |lA|lA|lA|[B|B|A|D[B|B|DIJA|B| D B|lAIND| D A A
Hydrocholoric Acid 20% D |[plc|ip|lAalD|A]A|]C|B|B|A[B|] C|A|D]|A D A A
Hydrofluoric Acid 20% pD IplplpblclclAalc|B|C|DJ|A[A|ND|BJA| A D |ND| A
Hydrogen Peroxide 10% B BID|A|A|A|A|A|BJ|A|AIJAIA A A|JC|IND| A A A
Isopropyl Alcohol 70% B [aAlAa|lA|B|ID|A|A|B|A]JAI[BIA] A B|A|ND| A A A
Methyl Alcohol 70% AlalalalalBlAalAalAalA|BIA|JA[NDIAJ|A|B A A A
Methylene Chloride B |B/B|lCc|D|C|A|ND]D|D|D|D|B| D D|A| D D D B
Phosphoric Acid >40% D |plplcl|lA|B|lA|A|B|A|A|JA|A| B BI{A]| A C A A
Propylene Glycol B |BlBIlBR|C|A|AINDICI|ND| B |AIA]| A C|lA|IND| A |[ND| A
Sodium Chlorate A |lelalc|Aa|lD|A|ND/A|A|A|N|A|[ND|[A]|JA|A C [ND| A
Sodium Hydroxide 20% B |B|lAlD|A|lA|A|B|[B|A|A|A|]A| A |A|A|ND| A A A
Sodium Hypochlorite <20% |C |C|D|[D|A|D|A[B|C|A|C|A[A| A A|C|[ND| B B A
Sodium Hypochlorite 0.5% B |[BIND|D|A|ND|A|B|CIND|C|A|A| A |A|C|ND| B A A
Sulfuric Acid <10% D |B|lD|B|A|A|A|A|B|A]|]AIJA|JAI A AJlA|l A C A A
Trichloroethylene B [B[D|D|D|C|AINDID|D|ND|D|C]| D D|A| D D D A
Virkon 10% ND|AIND[D]| A]| A|IND[A|NDIND| A [A[A] A A|AIND| A [ND]| A
This ratings information was obtained from several reputable sources and our own experience at BioTek, but your
experience may differ due to variations in concentration, temperature, and other factors. Consult the reagent/solvent
manufacturer before use to verify its compatibility with instrument components.

BioTek Instruments, Inc.



405 LS Customer Training Guide

Instrument

Hardware

Review flow routing and tubing
connection for Supply and Waste (page
12)

Review Mist Shield installation and
cleaning

Show location of washer aspirate/
dispense tubes, describe method of
operation and manifold design
Show location and function:

« priming trough

» carrier

« vacuum pump outlet

« fuse and describe how to replace it
Review ports:

. USB

« Vacuum Filtration

« waste monitor

Demonstrate Verify Technology (page
50)

Review Chemical Compatibility

Onboard Software

Show startup and priming procedure
Show Quick options:

o Prime

« Wash

» Clean: Sonicate Manifold
Select and run a protocol (page 40)
Create a protocol (page 33):

. Wash

o Aspirate

« Dispense

« Soak/Shake

« BioStack (page 53)
Show how to use Align utility
Explain/recommend AutoPrime (page 74)
Review end of day procedures

BioStack Interface

As applicable
Alignment kit, 90 or 0, or -90 degree wrist, 50-

plate stacks (if applicable)

Enable BioStack

Align gripper/claw

Potential issues with non-SBS compliant

microplates; microplate stack adjustment

« Demonstrate operation,
instrument control

« Instrument control
o LHC Control
« Settings/Restack




LHC Software

« Show how to establish communication

. Review the options in the Target Instrument Settings
. Create and run a simple protocol

« Review the Instrument Utilities dialog options

Preventive Maintenance

« Recommended maintenance schedule « Decontamination
(page 79) « Manifold cleaning procedures
. Cleaning in-bottle filter (page 86) « Stylus manifold
« Review programs: . Carrier cleaning procedures
« Day Rinse

« Overnight Loop
« Rinse and Soak
« Long Shutdown

Special Applications

As applicable
. Cell wash assays: define a protocol (page 55)
. Magnetic bead assays: review accessories; Magnet Adapter Height setting (page 60)

« Vacuum filtration assays: review accessories; enable module; Plate Carrier setting;
define a protocol (page 68)

Exercises
As applicable « Run a Quick Wash:
« Create a protocol for: . Buffer: D
o ELISA « Cycles: 2
« BioStack o Volume: 250 pL

Reference Material

. 405 LS Operator's Manual (on USB flash drive)
o LHCHelp
. BioStack Operator's Manual
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